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ABSTRAK 

 

Doni Setiawan. Studi Respon Bangunan Tidak Beraturan dengan Variasi 

Bukaan pada Shear wall terhadap Beban Gempa (Studi Kasus: Bangunan 

Apartemen Bassura City Tower Jasmine). Skripsi. Jakarta: Jurusan Teknik Sipil. 

Fakultas Teknik. Universitas Negeri Jakarta 

Penelitian ini dilakukan dengan tujuan untuk membandingkan respon bangunan 

ketika diberikan beberapa variasi posisi dan ukuran bukaan pada shear wall 

terhadap beban gempa dengan parameter ukur base shear, displacement, dan story 

drift. Penelitian ini dilakukan pada bangunan dengan kondisi tidak beraturan 

dengan studi kasus gedung Apartemen Bassura City Tower Jasmine. 

Penelitian ini akan dibuat 6 pemodelan shear wall mulai dengan 1 model tanpa 

bukaan dan 5 model dengan bukaan  yang divariasikan posisi dan ukurannya. Proses 

analisa dilakukan menggunakan software ETABS dan perencanaan beban gempa 

menggunakan analisis dinamis respon spektrum. 

Berdasarkan hasil penelitian dari ketiga parameter ukur respon bangunan yang 

ditinjau yaitu base shear, displacement, dan story drift menunjukan model 

bangunan dengan shear wall tanpa bukaan menghasilkan respon yang lebih baik 

dibandingkan 5 model lainnya yang terdapat bukaan. Terlihat adanya penurunan 

nilai base shear sekitar 6%-7% dan peningkatan nilai displacement sekitar 8,2% 

untuk arah X dan 52,78% untuk arah Y pada model dengan bukaan dibandingkan 

dengan model tanpa bukaan. Besarnya pengaruh tergantung akan ukuran dan 

posisinya. Dimana dibandingkan dengan model bukaan eksisting dan model bukaan 

lainnya model 3 yaitu bukaan dengan ukuran kecil dan posisi di pusat penampang 

shear wall menunjukan respon yang lebih baik dibandingkan dengan varisi model 

shear wall yang memiliki bukaan lainnya. Namun dari segi kinerja batas ultimit 

semua model masih dalam kondisi aman. 

Kata Kunci: Shear Wall, Bukaan Shear Wall, Respon Bangunan 
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ABSTRACT 

 

Doni Setiawan. Study Of Irregular Buiding Response With Variation Opening In 

Shear wall On Earthquake Load (Case Study: Building of Bassura City Tower 

Jasmine Apartment). Thesis. Jakarta: Department of Civil Engineering. Faculty of 

Engineering. State University of Jakarta 

 

The purpose of these research to compare building response with some position 

variation and opening shear wall dimensions to earthquake load with base shear, 

displacement, and story drift indicators. These research irregular condition 

buldings with study case Apartment Bassura City Tower Jasmine building. 

This research will make as 6 shear wall models starting with 1 model without 

openings and 5 models with openings in varied position and size. The analysis 

process is done by using ETABS software and earthquake load planning using 

dynamic analysis of spectrum response. 

Base on the results of research, from all three parameters of the measured building 

response, namely base shear, displacement, and story drift show the model of 

building with shear wall without opening have better response than 5 other models 

of openings. Seems like there is a decrease base shear value approximately 6%-7% 

and increase displacement value approximately 8,2% for X direction and 52,78% 

for Y direction on opening model compared without opening model. Compared to 

existing model openings, of model 3 the openings with small size and position in the 

center of the shear wall cross section showed a better response than the variation 

of shear wall model that has other openings. But in terms of ultimate performance 

limit all models are still in safe condition. 

 

Key Words: Shear wall, Openings, Building Response 
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BAB I 

PENDAHULUAN 

 

1.1. Latar Belakang 

Penerapan konsep bangunan tahan gempa terutama pada bangunan tinggi 

merupakan suatu hal yang harus terpenuhi, khususnya untuk daerah-daerah yang 

memiliki tingkat kerawanan terjadinya gempa cukup tinggi seperti Indonesia. 

Karena sifatnya yang fleksibel menyebabkan bangunan tinggi sangat rentan 

terhadap pergerakan tanah kuat, yang dapat menimbulkan deformasi yang 

berlebihan atau bahkan keruntuhan mendadak (Jingga, Suryanita, & Yuniarto, 

2015). Sehingga dalam perencanaannya perlu memperhatikan beberapa faktor yang 

dapat menunjang bangunan tersebut dalam menahan beban gempa. 

Bentuk dasar struktur bangunan merupakan salah satu faktor yang dapat 

mempengaruhi kemampuannya dalam menahan beban lateral yang salah satunya 

disebabkan oleh gempa bumi. Bangunan akan memiliki respon yang lebih baik 

sewaktu menerima gempa dengan bentuk denah yang sederhana dan simetris  

dibandingkan bangunan dengan bentuk denah asimetris yang mempunyai bagian-

bagian yang menonjol seperti bentuk L, U, H, T, Y dan bentuk lainnya (Nugroho, 

2016). 

Namun, banyaknya kebutuhan akan estetika dan fungsi sebuah bangunan 

menuntut adanya bentuk-bentuk struktur bangunan yang tidak biasa atau tidak 

beraturan baik secara horizontal maupun vertikal. Bangunan dengan bentuk ini 

menyebabkan letak titik berat bangunan tidak berada di tengah. Sehingga ketika 

terjadi gempa akan menimbulkan tingginya efek torsi yang terjadi, dan dampaknya 
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bangunan mengalami deformasi yang cukup besar (Juvientrian & Mughnie, 2014). 

Besarnya deformasi pada struktur bangunan dapat menyebabkan daya layan sruktur 

menurun. Oleh karena itu, pada bangunan-bangunan tinggi terutama dengan bentuk 

asimetris perlu adanya elemen-elemen pengaku yang dapat menunjang kinerja 

bangunan dalam menahan beban gempa. 

Dinding geser (shear wall) merupakan elemen pengaku yang dapat 

digunakan untuk meredam goyang pada bangunan tinggi, baik dalam bentuk 

simetris maupun asimetris yang beresiko tinggi terhadap beban gempa. Dinding 

geser merupakan dinding beton bertulang yang memiliki kekakuan bidang datar 

yang sangat besar yang ditempatkan pada lokasi tertentu untuk menyediakan 

tahanan beban horizontal (Pranata & Yunizar, 2011). Dinding geser yang efektif 

adalah yang bersifat kaku dan kuat. 

Penggunaan dinding geser sebagai sistem struktur utama bangunan 

khususnya pada apartemen, hotel atau kantor terkadang menimbulkan masalah pada 

desain arsitekturnya. Penempatan ruangan pada suatu bangunan sering kali 

menuntut shear wall memiliki bukaan yang biasanya difungsikan sebagai 

penempatan pintu, jendela, instalasi plumbing, dan instalasi listrik. Namun, 

pengurangan luas bruto penampang shear wall dapat membahayakan kekakuan, 

kekuatan, dan daktilitasnya terutama di bagian-bagian sudut bukaan (Elnashai & 

Sarno, 2008). Di mana kemampuan dan kekakuannnya akan menurun seiring 

dengan banyaknya bukaan pada penampangnya (Khatami, Mortezaei, & Barros, 

2012). Besarnya pengaruh sangat beragam tergantung pada ukuran dan posisi 

bukaan tersebut. Oleh karena itu, pada perencanaannya penempatan bukaan-bukaan 

pada dinding geser harus diperhitungkan dengan teliti agar bukaan dapat 
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ditempatkan pada bagian-bagian yang tidak akan berpengaruh banyak pada 

kekuatan shear wall. 

Dari beberapa bangunan, gedung Apartemen Bassura City Tower Jasmine 

merupakan salah satu contoh bangunan  tidak beraturan yang menggunakan sistem 

pengaku berupa dinding geser (shear wall) sebagai penahan gaya gempa. Bangunan 

dengan 2 Basement, 1 Lower Ground, 1 Ground Floor, dan 21 lantai ini memiliki 

beberapa tipe shear wall dengan posisi yang berbeda-beda. Namun, pada setiap 

shear wall yang berada pada sisi luar bangunan tersebut yaitu tipe W1J terdapat 

bukaan pada setiap penampangnya dengan ukuran 610 × 1310 mm. Bukaan tersebut 

difungsikan sebagai jendela dan diposisikan tidak pada pusat penampang shear 

wall. Posisi shear wall dan bukaan dapat dilihat pada Gambar 1.1. Posisi bukaan 

pada shear wall bangunan tersebut sebenarnya secara teoritis kurang 

menguntungkan terhadap kemampuan shear wall dalam menahan gempa. Menurut 

Khatami, dkk (2012) posisi bukaan yang terletak di pusat dinding geser adalah yang 

sesuai dalam meminimalkan penurunan kekuatan dan peningkatan deformasi.  

       

 

  

 

 

 

 

  

  (a)                                                              (b) 

Gambar 1.1 Bentuk Denah dan Bukaan  Pada Shear wall Bangunan 

Apartemen Bassura City Tower Jasmine 
Sumber: Dokumen Proyek 
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Berdasarkan uraian di atas maka dirasa perlu untuk mengetahui sampai 

seberapa jauh bukaan bisa diterapkan pada shear wall sebuah bangunan tinggi, 

dengan tidak mengurangi kemampuan layan shear wall terhadap beban gempa. 

Karena itu dilakukan penelitian mengenai bukaan pada shear wall dengan 

mengambil studi kasus pada gedung Apartemen Bassura City Tower Jasmine. 

 

1.2. Identifikasi Masalah 

Berdasarkan latar belakang yang telah diuraikan diatas, maka identifikasi 

masalah dalam penelitian ini adalah: 

1. Bagaimana respon bangunan Apartemen Bassura City Tower Jasmine dengan 

bukaan pada shear wall nya dalam menerima beban gempa? 

2. Seberapa besar perbedaan respon bangunan Apartemen Bassura City Tower 

Jasmine terhadap beban gempa yang menggunakan shear wall dengan dan 

tanpa bukaan? 

3. Bagaimana perbandingan respon yang akan timbul jika bukaan pada 

bangunan eksisting diberikan beberapa variasi posisi dan ukuran? 

4. Bagaimana bukaan yang efektif untuk diterapkan pada shear wall bangunan 

Apartemen Bassura City Tower Jasmine? 

 

1.3. Pembatasan Masalah 

Agar dapat lebih fokus dan terarah pada tujuan utama penelitian ini, maka 

perlu dibuat suatu batasan-batasan masalah. Adapun batasan masalah tersebut 

adalah sebagai berikut: 
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1. Bangunan yang ditinjau adalah gedung apartemen Bassura City Tower 

Jasmine yang berlokasi di Jakarta Timur terdiri dari 2 Basement, 1 Lower 

Ground, 1 Ground Floor, dan 21 Lantai dengan bentuk ketidakberaturan 

secara horizontal dan vertikal. 

2. Material yang digunakan adalah beton bertulang dengan mutu beton K-300, 

K-350, K-400, dan K-450 dengan mutu baja tulangan BJTD 40. 

3. Shear wall yang digunakan sebagai subjek penelitian ini hanya pada tipe W1J 

dengan ketebalan 350 mm 

4. Pada proses analisa akan dibuat 6 variasi bukaan termasuk didalamnya 

bukaan eksisting. 

5. Perencanaan beban mati dan beban hidup pada bangunan mengacu pada SNI 

03-1727-1989, SNI 03-1727-2013 tentang beban minimum untuk 

perancangan bangunan gedung dan struktur lain. 

6. Beban lateral yang ditinjau hanya beban gempa yang analisis perencanaannya 

menggunakan respon spektrum yang mengacu pada SNI 03-1726-2012 

tentang Tata Cara Perencanaan Ketahanan Gempa untuk Bangunan Gedung. 

7. Analisis struktur akan dilakukan menggunakan bantuan software ETABS 

v.9.7.4 dan ditinjau secara tiga dimensi. 

8. Dalam pemodelan struktur bangunan disesuaikan dengan gambar 

perencanaan dan tidak meninjau perubahan-perubahan yang terjadi di 

lapangan. 

9. Parameter respon bangunan yang dilihat berupa Displacement, Story drift, 

Base Shear. 
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1.4. Perumusan Masalah 

Berdasarkan pembatasan masalah diatas maka perumusan masalah dalam 

penelitian ini adalah “Bagaimana perbandingan respon bangunan tidak beraturan 

terhadap beban gempa pada studi kasus bangunan Apartemen Bassura City Tower 

Jasmine ketika diberikan beberapa variasi posisi dan ukuran bukaan pada shear 

wall-nya?” 

 

1.5. Tujuan Penelitian 

Berdasarkan perumusan masalah diatas maka tujuan dari penelitian ini 

dilakukan adalah membandingkan respon bangunan tidak beraturan terhadap beban 

gempa dengan berbagai variasi bukaan pada shear wall dan untuk mendapatkan 

proporsi bukaan yang optimum terhadap kinerja shear wall dalam menahan beban 

gempa. 

 

1.6. Kegunaan Penelitian 

Adanya penelitian ini diharapkan memberikan manfaat untuk berbagai 

kalangan yang berkaitan dengan dunia teknik sipil baik secara teortis maupun 

praktis. Adapun manfaat yang bisa didapatkan pada penelitian ini adalah sebagai 

berikut: 

1. Kegunaan teoritis 

Penelitian ini diharapkan dapat menambah pengetahuan bagi kalangan 

akademis mengenai kinerja shear wall terhadap beban gempa ketika 

diberikan bukaan pada penampangnya. 
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2. Kegunaan praktis 

Penelitian ini dapat digunakan sebagai tambahan informasi terhadap kalangan 

masyarakat untuk perencanaan ke depannya bagaimana bukaan yang 

optimum dapat diterapkan agar tidak mempengaruhi kinerja shear wall 

terhadap beban gempa secara signifikan jika kondisi bangunan tidak 

beraturan.
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BAB II 

KAJIAN TEORI 

 

2.1 Landasan Teori 

Pada sub bab ini akan diuraikan berbagai informasi dan teori-teori penunjang 

yang berkaitan dengan penelitian ini. Di mana segala teori tersebut diambil dari 

berbagai buku maupun jurnal-jurnal penelitian dalam rangka mendapatkan segala 

informasi yang ada sebelumnya berkaitan dengan judul untuk memperoleh landasan 

teori ilmiah.  

2.1.1 Konsep Dasar Gempa 

      Gempa didefinisikan sebagai getaran yang timbul secara alamiah pada lokasi 

tertentu yang disebabkan oleh pergerakan kerak bumi (lempeng bumi) secara tiba-

tiba (sudden slip). Pergeseran secara tiba-tiba ini terjadi karena adanya sumber gaya 

(force) yang disebabkan oleh beberapa sumber, baik yang bersumber dari aktivitas 

manusia maupun dari alam seperti gunung berapi, tanah longsor dan meteor yang 

menumbuk bumi. Walaupun pada dasarnya getaran ini sifatnya tidak berkelanjutan. 

Namun getaran yang dihasilkan disebarkan kesegala arah berupa gelombang 

sehingga efeknya dapat dirasakan sampai ke permukaan bumi (Suharjanto, 2013). 

Gempa bumi alamiah khususnya yang terjadi di daerah batas pertemuan antar 

lempeng yang menyusun kerak bumi dan di daerah sesar atau fault biasanya 

intensitasnya cukup besar. Hal ini yang membuat Indonesia merupakan negara yang 

cukup besar memiliki potensi terjadinya gempa bumi. Karena letak geografisnya 

yang berada pada pertemuan perbatasan tiga lempeng tektonik, yaitu  lempeng   

Australia, lempeng Pasifik, dan lempeng Euroasia.  Gempa bumi baik  yang  skala



9 

 
 

kecil maupun skala besar pernah terjadi di Indonesia (Suharjanto, 2013). 

Berdasarkan SNI 03-1726-2013 kini zonasi wilayah gempa Indonesia 

ditentukan berdasarkan parameter gerak tanah SS (percepatan batuan dasar periode 

pendek 0,2 detik) dan S1 (percepatan batuan dasar pada periode 1 detik) seperti yang 

ditunjukan pada Gambar 2.1 dan 2.2. Nilai SS dan S1 yang dihitung didasarkan pada 

fungsi-fungsi atenuasi atau persamaan prediksi goncangan tanah yang dianggap 

sesuai. Setiap daerah memiliki tingkat kerawan terjadinya gempa yang berbeda-

beda. Tingkat kerawanan terjadinya gempa dapat dilihat dengan besarnya nilai SS 

dan S1. Besarnya nilai SS dan S1 dilihat dari perbedaan warna. Warna terang 

menunjukan daerah tersebut memiliki tingkat kerawanan terjadinya gempa yang 

rendah. Sebaliknya tingkat kerawanan gempa menjadi tinggi ketika warna peta 

menjadi semakin gelap.  

Dalam perencanaan beban gempa yang akan bekerja pada suatu bangunan 

nilai SS dan S1  akan dijadikan acuan dalam menentukan nilai faktor amplifikasi 

terkait spektra percepatan berdasarkan jenis tanah, semakin lunak jenis tanah, 

semakin tinggi nilai faktor amplifikasi terkait spectra percepatan. Namun pada jenis 

tanah yang sama, semakin tinggi nilai SS dan S1 , nilai faktor amplifikasi terkait 

spectra percepatan semakin kecil (Sari, 2013) 
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Gambar 2.1 Zonasi Gempa Wilayah Indonesia Berdasarkan Parameter Ss 

Sumber: SNI 03-1726-2012 
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Gambar 2.2 Zonasi Gempa Wilayah Indonesia Berdasarkan Parameter S1 

Sumber: SNI 03-1726-2012 
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2.1.2 Sistem Bangunan Bertingkat Tinggi 

Bangunan bertingkat adalah bangunan yang mempunyai lebih dari satu lantai 

secara vertikal. Berdasarkan ketiggiannya bangunan bertingkat diklasifikasikan 

menjadi 3 yaitu bangunan bertingkat rendah, sedang, dan tinggi. Di mana bangunan 

bertingkat rendah merupakan bangunan dengan jumlah lantai 1 sampai 3 lantai 

dengan ketinggian kurang dari 10 m dan untuk bangunan kategori bertingkat sedang 

jumlah lantai 3 sampai 6 lantai dengan ketinggian kurang dari 20 m. Sedangkan  

bangunan bertingkat tinggi (High Rise Buildig) didefinisikan sebagai bangunan 

dengan tinggi lebih dari 6 lantai dengan ketinggian lebih dari 20 m (Mulyono, 

2000).  Bangunan tinggi biasanya menggunakan sistem struktur yang beraneka 

ragam, seperti struktur rangka dipadukan dengan sistem struktur lainnya. Serta 

elemen-elemen pelengkap sistem utilitas seperti alat transportasi vertikal, alat 

pemadam kebakaran aktif, alat pembersih bangunan gondola, dan lain-lain 

(Tangoro, 2006).  

Menurut Zuhri (2011) terdapat tiga aspek penting yang harus diperhatikan 

pada bangunan bertingkat tinggi. Ketiga aspek tersebut adalah kekuatan, kestabilan, 

dan keseimbangan yang artinya: 

1. Kekuatan 

Semua elemen dan komponen struktur bangunan harus mampu menahan 

beban-beban yang timbul baik yang bekerja secara vertikal ataupun 

horizontal. 

 

 

 



13 

 
 

2. Kestabilan 

Bangunan harus memberikan perilaku yang stabil ketika menerima beban 

khususnya beban lateral dari luar seperti angin dan gempa ataupun gaya 

gravitasi bumi. 

3. Keseimbangan 

Dalam hal ini perilaku bangunan harus mampu mengatasi gaya gravitasi dan 

lateral, di mana perilaku struktur dicapai dengan memberikan bidang-bidang 

vertikal masif seperti dinding geser yang berfungsi untuk meneruskan beban 

dan membentuk sudut dengan permukaan tanah. 

Intinya hal terpenting pada struktur bangunan bertingkat tinggi adalah 

stabilitas dan kemampuannya menahan gaya lateral baik yang disebabkan oleh 

angin ataupun gempa bumi (Juwana, 2005). Hal ini dikarenakan sifat bangunan 

tinggi yang cenderung fleksibel sehingga membuatnya sangat rentan ketika 

menerima pergerakan tanah kuat, sehingga menimbulkan deformasi yang 

berlebihan atau bahkan keruntuhan mendadak (Jingga, Suryanita, & Yuniarto, 

2015) 

Secara proses, gempa bumi ini merambat dalam bentuk gelombang yang 

mempunyai suatu energi sehingga menyebabkan permukaan bumi atau permukaan 

tanah bergetar. Getaran tanah tersebut kemudian menggoyangkan pondasi yang 

merupakan titik singgung antara bangunan dengan tanah secara bolak-balik. Gerak 

ini akan ditahan oleh massa bangunan, yang akan menimbulkan gaya inersia pada 

seluruh struktur. Besar gaya inersia horizontal (F) bergantung pada beberapa faktor 

yaitu massa bangunan (m), percepatan permukaan (a) dan sifat struktur tersebut. 

Bangunan dengan pondasi kaku, membuat percepatannya akan sama dengan 



14 

 
 

permukaan seperti pada gambar 2.3(a). Namun pada kenyataannya hal ini tidaklah 

demikian karena pada jumlah tingkatan tertentu, beberapa bangunan memiliki sifat 

yang fleksibel. Untuk struktur yang hanya sedikit berubah bentuk, besar gayanya 

akan kurang dari massa kali percepatannya seperti pada Gambar 2.3 (b). Akan tetapi 

struktur bangunan yang memiliki sifat sangat fleksibel sehingga memiliki waktu 

getar alamiah yang mendekati waktu getar gelombang permukaan. Hal ini 

menyebabkan bangunan tersebut akibat mengalami gaya yang jauh lebih besar 

akibat gerak permukaan yag berulang-ulang seperti pada gambar 2.3 (c) (Schueller, 

2001). 

 

 

 

 

 

(a)                                (b)                           (c) 

Gambar 2.3 Perilaku Bangunan Ketika Menerima Gempa 

Sumber : Schueller, 2001 

     Oleh karena itu, struktur bangunan bertingkat tinggi memiliki tantangan 

tersendiri dalam perencanaannya, terutama bila bangunan terletak di wilayah yang 

memiliki faktor resiko yang cukup besar terhadap gempa salah satunya di 

Indonesia. SNI 03-1726-2016 telah mengklasifikasikan beberapa kategori resiko 

bangunan terhadap gempa berdasarkan fungsi bangunannya seperti yang 

ditunjukkan pada Tabel 2.1 sebagai acuan dalam mendesain gempa rencana untuk 

bangunan di Indonesia. Pengelompokan ini ditinjau dari faktor fungsi dari 

bangunan tersebut. Semakin kompleks fungsinya, sehingga bangunan tersebut 
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memiliki resiko yang cukup tinggi ketika terjadi gempa maka akan diklasifikasikan 

kedalam kategori resiko yang terbesar dan sebaliknya. 

Tabel 2.1 Kategori Resiko Bangunan Gedung dan Non Gedung 

Jenis Pemanfaatan 
Kategori 

Risiko 

Gedung dan non gedung yang memiliki risiko rendah terhadap jiwa 

manusia pada saat terjadi kegagalan, termasuk, tapi tidak dibatasi 

untuk, antara lain: 

- Fasilitas pertanian, perkebunan, perternakan, dan perikanan 

- Fasilitas sementara 

- Gudang penyimpanan 

- Rumah jaga dan struktur kecil lainnya 

I 

Semua gedung gan struktur lain, kecuali yang termasuk dalam 

kategori risiko I, III, IV, termasuk, tapi tidak dibatasi untuk: 

- Perumahan 

- Rumah toko dan rumah kantor 

- Pasar 

- Gedung perkantoran 

- Gedung apartemen/ rumah susun 

- Pusat perbelanjaan/ mall 

- Bangunan industri 

- Fasilitas manufaktur 

- Pabrik  

II 

Gedung dan non gedung yang memiliki risiko tinggi terhadap jiwa 

manusia pada saat terjadi kegagalan, termasuk, tapi tidak dibatasi 

untuk: 

- Bioskop 

- Gedung pertemuan 

- Stadion 

- Fasilitas kesehatan yang tidak memiliki unit bedah dan unti 

gawat darurat 

- Fasilitas penitipan anak 

- Penjara 

- Bangunan  

Gedung dan non gedung yang tidak termasuk dalam kategori risiko 

IV, (termasuk, tetapi tidak dibatasi untuk fasilitas manufaktur, 

proses, penanganan, penyimpanan, penggunaan atau tempat 

pembuangan bahan bakar berbahaya, bahan kimia berbahaya, limbah 

berbahaya, atau bahan yang mudah meledak) yang mengandung 

bahan beracun atau peledak di mana jumlah kandungan bahanya 

melebihi nilai batas yang disyaratkan oleh instansi yang berwenang 

dan cukup menimbulkan bahaya bagi masyarakat jika terjadi 

kebocoran. 

III 
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Jenis Pemanfaatan 
Kategori 

Resiko 

Gedung dan non gedung yang ditunjukkan sebagai fasilitas yang 

penting, termasuk, tetapi tidak dibatasi untuk: 

- Bangunan-bangunan monumental 

- Gedung sekolah dan fasilitas pendidikan 

- Rumah sakit dan fasilitas kesehatan lainnya yang memiliki 

fasilitas bedah dan unit gawat darurat 

- Fasilitas pemadam kebakaran, ambulans, dan kantor polisi, 

serta garasi kendaraan darurat 

- Tempat perlindungan terhadap gempa bumi, angin badai, dan 

tempat perlindungan darurat lainnya  

- Fasilitas kesiapan darurat, komunikasi, pusat, operasi dan 

fasilitas lainnya untuk tanggap darurat 

- Pusat pembangkit energi dan fasilitas public lainnya yang 

dibutuhkan pada saat keadaan darurat 

- Struktur tambahan (termasuk menara telekomunikasi, tangki 

penyimpanan bahan bakar, menara pendingin, struktur 

stasiun listrik, tangki air, pemadam kebakaran atau struktur 

rumah atau struktur pendukung air atau material atau 

peralatan pemadam kebakaran) yang disyaratkan untuk 

beroperasi pada saat keadaan darurat 

 

Gednung dan non gedung yang dibutuhkan untuk mempertahankan 

fungsi struktur bangunan lain yang masuk kedalam kategori risiko 

IV. 

IV 

Sumber: SNI 03-1726-2012 

Tabel 2.2 Faktor Keutamaan Gempa 

Kategori Risiko Faktor Keutamaan, Ie 

I atau II 1,0 

III 1,25 

IV 1,50 
Sumber: SNI 03-1726-2012  

 

2.1.2.1 Respon Bangunan Terhadap Gempa 

Menurut SNI 03-1726-2012 respon bangunan terhadap gempa diwujudkan 

dalam : 

 



17 

 
 

1. Simpangan antar lantai tingkat 

Pada dasarnya suatu struktur khususnya pada bangunan tinggi harus 

memiliki kekakuan yang cukup sehingga pergerakannya akibat beban lateral 

dapat dibatasai. Kekakuan struktur dapat diukur dari besarnya simpangan 

antar lantai bangunan, semakin kecil simpangan struktur maka bangunan 

tersebut akan semakin kaku (Smith & Coull, 1991). Simpangan terdiri dari 

dua jenis yaitu, displacement dan drift. Perbedaannya displacement adalah 

simpangan suatu lantai diukur dari dasar lantai sedangkan drift adalah 

simpangan suatu lantai diukur dari dasar lantai dibawahnya. 

Berdasarkan SNI 03-1726-2012 penentuan simpangan antar lantai 

tingkat desain (∆) harus dihitung sebagai perbedaan defleksi pada pusat massa 

di tingkat teratas dan terbawah yang ditinjau. Apabila pusat massa tidak 

terletak segaris dalam arah vertikal, diizinkan untuk menghitung defleksi di 

dasar tingkat berdasarkan proyeksi vertikal dan pusat massa di tingkat 

atasnya. 

Defleksi pusat massa di tingkat x di pusat massa (𝛿𝑥) harus ditentukan 

sesuai dengan persamaan berikut: 

𝛿𝑥 =
𝐶𝑑𝛿𝑥𝑒

𝐼𝑒
             (2.1) 

Keterangan: 

𝐶𝑑 = faktor pembesaran defleksi 

𝛿𝑥𝑒 = defleksi pada lokasi yang disyaratkan 

𝐼𝑒  = faktor keutamaan 

 

 Sesuai dengan SNI 03-1726-2012, nilai simpangan antar tingkat desain 

(∆) memiliki syarat nilainya harus lebih kecil dari simpangan antar lantai 
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tingkat ijin (∆𝑎) sesuai dengan Tabel 2.3 untuk semua tingkat. Kemudian 

khusus untuk sistem penahan gaya gempa yang terdiri dari hanya rangka 

momen pada struktur yang dirancang utuk kategori desain seismic D,E atau 

F, syaratnya nilai simpangan antar lantai tingkat desain (∆) harus kurang dari 

∆/𝜌 untuk semua tingkat nilai 𝜌 adalah 1,3 

Tabel 2.3 Simpangan Antar Lantai Tingkat Ijin (∆𝒂) 

Struktur 
Kategori Risiko 

I atau II III IV 

Struktu, selain dari struktur dinding 

geser batu bata, 4 tingkat atau kurang 

dengan dinding interior, partisi, 

langit-langit dan sistem dinding 

eksterior yang telah didesain untuk 

mengakomodasi simpangan antar 

lantai tingkat 

0,025 hsx 0,020 hsx 0,015 hsx 

Struktur dinding geser kantilever 

batu bata 
0,010 hsx 0,010 hsx 0,010 hsx 

Struktur dinding geser batu bata 

lainnya 
0,007 hsx 0,007 hsx 0,007 hsx 

Semua struktur lainnya 0,020 hsx 0,015 hsx 0,010 hsx 
           Sumber: SNI 03-1726-2012 

     Besarnya simpangan antar lantai suatu bangunan dapat dipengaruhi 

oleh gaya geser dasar. Gaya geser dasar ini merupakan gaya geser atau lateral 

maksimum yang akan diterima bangunan akibat aktivitas seismik pada 

tingkat dasar. Gaya geser dasar yang akan diterima bangunan kemudian akan 

didistribusikan secara vertikal sepanjang tinggi struktur sebagai gaya 

horizontal tingkat yang bekerja pada masing-masing tingkat bangunan. 

Akibat dari gaya yang bekerja pada setiap tingkat tersebut maka akan 

mengakibatkan terjadinya perpindahan atau simpangan pada tingkat-tingkat 

tersebut (Cornelis, Bunganaen, & Tay, 2014). Berdasarkan SNI 03-1726-
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2012 geser dasar (V) secara statis dalam arah yang ditetapkan harus 

ditentukan sesuai dengan persamaan berikut: 

𝑉 =  𝐶𝑠𝑊            (2.2)   

Keterangan: 

𝐶𝑠 = koefisien respon seismik 

𝑊 = berat seismik efektif 

 

Koefisien respon seismik dapat ditentukan dengan persamaan berikut: 

𝐶𝑠 =
𝑆𝐷𝑆

(
𝑅

𝐼𝑒
)
             (2.3) 

Keterangan: 

𝑆𝐷𝑆 = parameter percepatan desain respon spektrum dalam rentang 

                  perioda pendek 

𝑅 = faktor modifikasi respon 

𝐼𝑒 = faktor keutamaan gempa 

 

 Berdasarkan SNI 03-1726-2013 untuk nilai gaya geser dasar yang didapat 

dari perhitungan dinamis nilainya harus tidah boleh lebih kecil dari 85% nilai 

gaya geser dasar yang dihitung menggunakan metode statis. 

2. Deformasi 

Deformasi adalah perubahan posisi atau adanya pergerakan suatu titik 

dan perubahan bentuk struktur akibat adanya gaya dari luar maupun dari 

dalam yang terjadi di sepanjang tingkatan lantai. Oleh karena itu, untuk 

memberikan kekuatan dan kekauan struktur untuk mampu menahan gerak 

tanah desain perlu adanya sistem penahan gaya lateral dan vertikal yang 

lengkap. 
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3. Defleksi Diafragma 

Defleksi pada bidang diafragma, seperti ditentukan dengan analisis 

rekayasa, tidak boleh melebihi defleksi ijin elemen yang terhubung. Defleksi 

ijin harus merupakan defleksi yang akan mengijinkan elemen yang terhubung 

untuk mempertahankan integritas strukturnya akibat pembebanan individu 

dan terus mendukung beban yang ditetapkan. 

Defleksi pusat massa di tingkat 𝑥 (𝛿𝑥) (mm) harus ditentukan sesuai 

dengan persamaan berikut: 

𝛿𝑥 =  
𝑐𝑑𝛿𝑥𝑒   

𝐼𝑒 
 

Keterangan : 

𝑐𝑑 = faktor amplikasi defleksi 

𝛿𝑥𝑒 = defleksi pada lokasi yang disyaratkan pada anilisis elastis 

𝐼𝑒 = faktor keutamaan gempa  

 

2.1.3 Ketidakberaturan Bangunan 

Salah satu aspek penting dalam perancangan struktur bangunan tahan gempa 

adalah pemilihan bentuk dasar suatu struktur bangunan. Bentuk bangunan dengan 

ketidakberaturan termasuk salah satu aspek dalam perancangan struktur yang 

memiliki potensi lebih besar akan terkena bahaya gempa (MacGregor, 2005). 

Bangunan dengan bentuk ini menyebabkan letak titik berat bangunan tidak berada 

di tengah. Sehingga ketiga terjadi gempa akan menimbulnya tingginya efek torsi 

yang terjadi, dan dampaknya bangunan mengalami deformasi yang cukup besar 

(Juvientrian & Mughnie, 2014). Deformasi yang cukup besar inilah yang dapat 

menyebabkan daya layan struktur menurun. 
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Ketidakberaturan bentuk dari suatu bangunan menghasilkan suatu analisa 

yang lebih rumit dibandingkan bentuk bangunan beraturan. Perilaku dari struktur 

ketidakberaturan yang diberikan suatu gaya gempa akan menghasilkan suatu 

perpindahan yang nilainya berbeda-beda pada tiap lantainya. Perpindahan yang 

terjadi untuk analisa 3 dimensi akan memberikan perpindahan translasi pada arah 

sumbu-x, sumbu-y, serta rotasi yang secara langsung terjadi akibat gaya gempa. 

Rotasi yang terjadi pada struktur tidak beraturan akibat adanya perbedaan letak titik 

pusat massa dan pusat kekakuan (Wisnumurti, Cahya, & Anas, 2008) 

Berdasarkan SNI 03-1726-2012 ketidakberaturan struktur dibagi menjadi dua 

macam klasifikasi. Klasifikasi tersebut didasarkan pada konfigurasi secara 

horizontal dan vertikal. 

2.1.3.1 Ketidakberaturan Horizontal 

Bangunan ditetapkan sebagai ketidakberaturan horizontal berdasarkan 

kepada ketidakberaturan arah sumbu x-y. berdasarkan SNI 03-1726-2012 terdapat 

beberapa tipe ketidakberaturan horizontal seperti yang ditunjukan pada Tabel 2.4 

Tabel 2.4 Ketidakberaturan Horizontal pada Struktur 

 Tipe dan penjelasan 

ketidakberaturan 

Ilustrasi 

1a Ketidakberaturan torsi didefinisikan 

ada jika simpangan antar lantai tingkat 

maksimum, torsi yang dihitung termasuk 

tak terduga, disebuah ujung struktur 

melintang terhadap sumbu lebih dari 1,2 

kali simpangan antar lantai tingkat rata-

rata dikedua ujung struktur. Persyaratan 

ketidakberaturan torsi dalam pasal-pasal 

referensi berlaku hanya untuk struktur di 

mana diafragmanya kaku aatu setengah 

kaku. 
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1b Ketidakberaturan torsi berlebihan 

didefinisikan ada jika simpangan antar 

lantai tingkat maksimum, torsi yang 

dihitung termasuk tak terduga, disebuah 

ujung struktur melintang terhadap sumbu 

lebih dari 1,4 kali simpangan antar lantai 

tingkat rata-rata di kedua ujung struktur. 

Persyaratan ketidakberaturan torsi 

berlebihan dalam pasal-pasal referensi 

berlaku hanya untuk struktur di mana 

diafragmanya kaku atau setengah kaku. 

2 Ketidakberaturan sudut dalam 

didefinisikan ada jika kedua proyeksi 

denah struktur dari sudut dalam lebih 

besar dari 15 persen dimensi denah 

struktur dalam arah yang ditentukan. 

 

 

 

3 Ketidakberaturan diskontinuitas 

diafragma didefinisikan ada jika 

terdapat diafragma dengan 

diskontinuitas atau variasi kekakuan 

mendadak, termasuk yang mempunyai 

daerah terpotong atau terbuka lebih besar 

dari 50 persen daerah diafragma bruto 

yang melingkupinya, atau perubahan 

kekakuan diafragma efektif lebih dari 50 

persen dari suatu tingkat ke tingkat 

selanjutnya 

 

4 Ketidakberaturan pergeseran 

melintang terhadap bidang 
didefinisikan ada jika terdapat 

diskontinuitas dalam lintasan tahanan 

gaya lateral, seperti pergeseran 

melintang terhadap bidang elemen 

vertikal. 

 

 

5 Ketidakberaturan sistem nonparallel 

didefinisikan ada jika elemen penahan 

gaya lateral vertikal tidak paralel atau 

simetris terhadap sumbu-sumbu 

orthogonal utama sistem penahan gaya 

gempa 

 

 

 

Sumber: SNI 03-1726-2012 
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2.1.3.2 Ketidakberaturan Vertikal 

     Bangunan ditetapkan sebagai ketidakberaturan vertikal berdasarkan kepada 

ketidakberaturan arah sumbu x-z atau y-z. berdasarkan SNI 03-1726-2012 terdapat 

beberapa tipe ketidakberaturan horizontal seperti yang ditunjukan pada Tabel 2.5. 

Tabel 2.5 Ketidakberaturan Horizontal pada Struktur 

 Tipe dan penjelasan 

ketidakberaturan 

Ilustrasi 

1a Ketidakberaturan Kekakuan Tingkat 

Lunak didefinisikan ada jika terdapat 

suatu tingkat di mana kekakuan 

lateralnya kurang dari 70 persen 

kekakuan lateral tingkat di atasnya 

kurang dari 80 persen kekakuan rata-

rata tiga tingkat diatasnya. 

 

 

 

1b Ketidakberaturan Kekakuan Tingkat 

Lunak  Berlebihan didefinisikan ada 

jika terdapat suatu tingkat di mana 

kekakuan lateralnya kurang dari 60 

persen kekakuan lateral tingkat di 

atasnya kurang dari 70 persen kekakuan 

rata-rata tiga tingkat diatasnya. 

 

 

2 Ketidakberaturan Berat (Massa) 

didefinisikan ada jika massa efektif 

semua tingkat lebih dari 150 persen 

massa efektif tingkat didekatnya. Atap 

yang lebih ringan dari lantai di 

bawahnya tidak perlu ditinjau. 

 

 

 

3 Ketidakberaturan Geometri Vertikal 

didefinisikan ada jika dimensi 

horizontal sistem penhan gaya gempa di 

semua tingkat lebih dari 130 persen 

dimensi horizontal sistem penahan gaya 

gempa tingkat di dekatnya. 
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 Tipe dan penjelasan 

ketidakberaturan 

Ilustrasi 

4 Diskontinuitas Arah Bidang dalam 

Ketidakberaturan Elemen Penahan 

Gaya Lateral Vertikal didefinisikan 

ada jika pergeseran arah bidang elemen 

penahan gaya lateral lebih besar dari 

panjang elemen itu atau terdapat reduksi 

kekakuan elemen penahan di tingkat di 

bawahnya. 

 

 

 

5a Diskontinuitas dalam 

Ketidakberaturan Kuat Lateral 

Tingkat didefinisikan ada jika kuat 

lateral tingkat kurang dari 80 persen 

kuat lateral tingkat di atasnya. Kuat 

lateral tingkat adalah kuat lateral total 

semua elemen penahan seismik yang 

berbagi geser tingkat untuk arah yang 

ditinjau. 

 

5b Diskontinuitas dalam 

Ketidakberaturan Kuat Lateral 

Tingkat didefinisikan ada jika kuat 

lateral tingkat kurang dari 65 persen 

kuat lateral tingkat di atasnya. Kuat 

lateral tingkat adalah kuat lateral total 

semua elemen penahan seismik yang 

berbagi geser tingkat untuk arah yang 

ditinjau. 
Sumber: SNI 03-1726-2012 

 

2.1.3.3 Sistem Pemisah Late Pour Strip 

Terkadang bangunan dengan denah yang cukup lebar ataupun panjang perlu 

menerapkan sistem pemisah untuk menghindari terjadinya distori akibat perbedaan 

penurunan tanah (diferential settlement), karena tidak dapat dipungkiri pada suatu 

bangunan terkadang kondisi tanahnya berbeda-beda. Salah satu sistem pemisah 

yang dapat mengatasi hal tersebut adalah sistem late  pour  strip ini. late  pour  strip 

adalah sebuah strip/ celah sekitar 30 sampai 36 inci antara dua lempeng wilayah 
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yang akan dibangun. Biasanya sistem  ini  merupakan bagian dari pelat beton yang 

dibiarkan terbuka selama 30 sampai dengan 60 hari untuk untuk pelat mengalami 

penyusutan, shingga membiarkan pelat yang berdekatan sebagai segmen individu, 

bukan sebagai bagian dari struktur total (Bondy & Allreo, 2013). Nantinya celah 

yang memisahkan kedua plat tersebut dicor menggunakan beton non shrink.  

 

 

 

 

 

Gambar 2.4 Late Pour Strip 

Bondy & Allreo, 2013 
 

2.1.4 Dinding Geser (Shear wall)  

Dinding geser merupakan salah satu sistem elemen struktur yang sangat 

efektif dalam menahan gaya lateral. Dinding geser adalah dinding beton bertulang 

dengan kekakuan bidang datar yang sangat besar yang ditempatkan pada lokasi 

tertentu untuk menyediakan tahanan beban horizontal (Pranata & Yunizar, 2011). 

Dinding geser biasanya ditempatkan di luar, di dalam atau berupa inti (core) untuk 

ruang lift atau tangga.  

Dinding geser pada dasarnya merupakan balok kantilever vertikal yang tinggi 

dan memberikan stabilitas lateral kepada struktur dengan menahan geser dan 

momen tekuk pada bidang datar yang disebabkan gaya-gaya lateral (McCormac, 
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2003). Sehingga diharapkan struktur yang diberikan dinding geser akan lebih kaku 

untuk menyerap dan menahan gaya geser. 

Dalam struktur bangunan bertingkat, dinding geser sangat penting, karena 

selain untuk mencegah kegagalan dinding eksterior, dinding geser juga mendukung 

beberapa lantai gedung dan memastikan bahwa struktur tidak runtuh karena 

gerakan lateral akibat gempa bumi. Menurut Lumban (2016) Dinding geser pada 

dasarnya memiliki 2 fungsi utama yaitu: 

1. Kekuatan 

Dinding geser harus mampu memberikan kekuatan lateral yang diperlukan 

untuk melawan kekuatan beban gempa horizontal. Sehingga nantinya dinding 

geser dapat mentrasfer gaya horizontal ini ke elemen-elemen struktur lain 

berikutnya seperti dinding geser lainnya, lantai, pondasi dinding. 

2. Kekakuan 

Dinding geser juga memberikan kekakuan lateral untuk mencegah atap atau 

lantai diatas dari sisi-goyangan yang berlebihan. Sehingga bangunan yang 

cukup kaku biasanya hanya akan mengalami kerusakan nonstruktural. 

Dinding geser sebagai elemen penahan gaya lateral memiliki keuntungan 

utama karena menyediakan kontinuitas vertikal pada sistem lateral struktur gedung. 

Struktur gedung dengan dinding geser sebagai elemen penahan gaya lateral 

umumnya memiliki kinerja yang cukup baik pada saat gempa (Fintel, 1991). 
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2.1.4.1 Sistem Kerja Dinding Geser  

Dinding geser adalah unsur pengaku vertikal yang dirancang untuk menahan 

gaya lateral atau gempa yang bekerja pada bangunan. Pada prinsipsnya bagian 

struktur yang relatif kaku akan menarik gaya jauh lebih besar daripada bagian yang 

fleksibel. Oleh karena itu, dinding geser yang efektif haruslah kaku dan kuat. 

Sehingga struktur dengan dinding geser dapat memiliki performa yang baik dalam 

menahan gaya gempa. Namun sebaliknya, jika dinding geser rapuh dan runtuh sisa 

struktur lainnya tidak akan menahan getaran gempa yang terjadi dan akhirnya 

terjadi keruntuhan pada bangunan tersebut. 

Pada sistem kerjanya gaya lateral yang terjadi pada suatu gedung, baik 

diakibatkan oleh beban gempa maupun angin akan disebar melalui struktur lantai 

yang berlaku sebagai diafragma horizontal terhadap dinding geser, yang sejajar 

dengan aksi gaya. Kemudian dinding geser ini akan menahan aksi tersebut. Karena 

sifatnya yang sangat kaku, dinding geser yang berperan sebagai balok yang tebal, 

akan bereaksi terhadap gaya geser (Schueller, 2001). 

Dinding geser dengan lebar yang besar akan menghasilkan daya lentur dan 

geser yang sangat tinggi. Pada Gambar 2.5 ditunjukan bagaimana deformasi yang 

terjadi ketika dinding geser terkantilever dengan stuktur rangka bekerja secara 

individual dalam menahan beban lateral. Deformasi portal terbuka dan dinding 

geser terkantilever yang memikul gaya gempa secara terpisah terlihat perbedaan 

dari deformasi yang terjadi dari kedua sistem tersebut. Deformasi pada dinding 

kantilever menyerupai deformasi balok kantilever yang tegak lurus tanah dan selain 

deformasi lentur, dinding mengalami deformasi geser dan rotasi secara keseluruhan 

akibat deformasi tanah. Perbedaan dari kedua sistem terlihat bahwa pada deformasi 
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portal terbuka besarnya cenderung sama pada tingkat atas dan bawah, sedangkan 

deformasi pada dinding geser sangat kecil di dasar dan besar di puncak (Schueller, 

2001). 

 

 

 

 

 

 

 

 

 

 

Gambar 2.5 Deformasi Portal Terbuka dan Dinding Geser 
Sumber : Juwana, 2005 

 

Pada bangunan tinggi biasanya untuk meningkatkan kekakuan dalam 

kekuatan struktur terhadap gaya lateral diterapkan kombinasi diantara rangka kaku 

dengan dinding geser. Pada kombinasi keduanya ini dinding geser dan kolom-

kolom struktur pada rangka akan dihubungkan secara kaku menggunakan balok-

balok disetiap lantai bangunan. Adanya hubungan yang kaku antar ketiga elemen 

tersebut akan memungkinkan timbulnya interaksi antar struktur rangka dan dinding 

geser yang akan bekerja bersama-sama dalam menahan beban yang bekerja 

terutama beban lateral. Sehingga adanya interaksi dari keduanya menyebabkan 

simpangan lateral akan jauh berkurang seiring dengan peningkatan jumlah lantai 

struktur. Interaksi antara keduanya menghasilkan deformasi berbentuk s datar 

seperti yang ditunjukan pada Gambar 2.6. Karena sifat defleksi yang berbeda antara 

dinding geser dengan sistem rangka menyebabkan dinding geser menahan 

simpangan rangka kaku pada bagian bawah, sedangkan rangka kaku akan menahan 
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simpangan dinding geser pada bagian atas. Dengan demikian, geser akibat gaya 

lateral akan dipikul oleh rangka pada bagian atas bangunan dan dipikul oleh dinding 

geser dibagian bawah bangunan . (Schueller, 2001). 

 

 

 

 

Gambar 2.6 Sistem Kerja Portal Terbuka dan Dinding Geser  
Sumber : Schueller, 2001 

 

Pada prinsipnya dinding geser bekerja sebagai sebuah balok kantilever 

vertikal yang menyediakan tahanan lateral dan menyebabkan dinding geser 

menerima gaya tekuk maupun geser. Dengan demikian, dinding geser harus cukup 

kuat menahan gaya geser yang terjadi pada struktur. Berdasarkan SNI 03-2847-

2013 kuat geser nominal 𝑉𝑐 dinding geser diambil dari nilai yang lebih kecil dari 

nilai yang dihitung dari persamaan 2.4 dan 2.5. 

𝑉𝑐 = 0,27𝜆√𝑓𝑐′ℎ𝑑 +  
𝑁𝑢𝑑

4𝑙𝑤
           (2.4) 

Atau 

𝑉𝑐 = [0,05𝜆√𝑓𝑐′ +  
𝑙𝑤(0,1𝜆√𝑓𝑐′+0,2

𝑁𝑢
𝑙𝑤ℎ

)

𝑀𝑢
𝑉𝑢

− 
𝑙𝑤
2

] ℎ𝑑         (2.5) 

Keterangan: 

𝑉𝑐  = kuat geser nominal 

𝜆 = faktor modifikasi 

h = tebal dinding 

d = diambil 0,8 𝑙𝑤 
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𝑙𝑤 = panjang keseluruhan dinding 

𝑁𝑢 = gaya aksial terfaktor tegak lurus terhadap penampang yang terjadi  

serentak dengan 𝑉𝑢 ( diambil sebagai positif untuk tekan dan negative 

untuk tarik) 

𝑉𝑢 = gaya geser terfaktor pada penampang 

𝑀𝑢 = momen terfaktor pada penampang 

2.1.4.2 Bukaan Dinding Geser 

Penerapan dinding geser pada bangunan-bangunan tinggi seperti apartemen, 

hotel, kantor, dan sebagainya terkadang membuat dinding geser memiliki bukaan 

pada penampangnya karena untuk kebutuhan ruangan dan estetika. Biasanya 

bukaan pada dinding geser digunakan untuk jendela, pintu, saluran-saluran 

mekanikal dan elektrikal. Ukuran dan lokasi bukaan dapat bervariasi tergantung 

dari fungsinya. 

Namun adanya pengurangan luas bruto penampang shear wall dapat 

membahayakan kekakuan, kekuatan, dan daktilitasnya terutama dibagian-bagian 

sudut bukaan (Elnashai & Sarno, 2008). Hal ini dikarenakan keadaan shear wall 

yang diskontinuitas menyebabkan terjadinya konsentrasi tegangan dan pergeseran 

lateral, dan dalam beberapa kasus menyebabkan respon seimik yang tidak 

diinginkan. Sehingga adanya bukaan pada shear wall ini nantinya akan mengurangi 

kemampuannya dalam menahan gaya lateral. Meskipun demikian, biasanya dengan 

perencanaan yang teliti bukaan dapat diterapkan untuk ukuran dan posisi tertentu 

yang tidak akan memiliki pengaruh yang signifikan terhadap kemampuan dinding 

geser dalam menahan beban lateral (MacGregor, 2005). 

Pada dasarnya ketika beban lateral diaplikasikan di tepi atas shear wall 

dengan bukaan, gaya geser akan bekerja pada ujung-ujung vertikal penampang dan 

pada bagian atas dan bawah bukaan akan menghasilkan efek kontra-lentur. Di mana 
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titik belok diasumsikan terjadi pada titik tengah tinggi dan panjang dinding geser 

dan momen maksimum terjadi pada setiap tepi setiap segmen bukaan (Malone & 

Rice, 2012). Hal tersebut seperti yang ditunjukan pada Gambar 2.7. 

 

 

 

 

 

 

Gambar 2.2 Mekanisme Dinding Geser Menerima Beban Lateral 
Sumber: Malone & Rice, 2012 

 

     Ukuran bukaan dapat bervariasi tergantung dari fungsinya. Jika ukuran bukaan 

tersebut kecil, maka pengaruh yang akan diakibatkannya juga kecil terhadap 

dinding geser. Namun sebaliknya jika bukaan berukuran besar akan memberikan 

pengaruh yang cukup besar pula terhadap kekauan dinding geser (MacGregor, 

2005). Untuk ukuran bukaan kecil, dinding geser berperilaku seperti kolom 

kantilever monolit yang pengaruhnya dapat diabaikan. Bukaan dengan ukuran kecil 

adalah bukaan dengan lebar (𝑙0) kurang dari 10-15% dari panjang dinding (𝐿𝑤) 

seperti yang ditunjukan pada gambar 2.8 (a). sedangkan untuk ukuran bukaan yang 

besar seperti pada gambar 2.8 (b) dinding akan berperilaku sebagai dinding geser 

berangkai (coupeled shear wall) yaitu suatu sistem dinding yang dihubungkan oleh 

lantai kaku atau balok (spandrels) disetiap lantai. Deformasi sistem ini tergantung 

pada kekakuan balok penghubungnya (Elnashai & Sarno, 2008). 
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(a)                                                     (b) 

Gambar 2.3 Dinding Geser dengan Bukan Kecil dan Besar 
Sumber: Elnashai & Sarno, 2008 

 

      Posisi bukaan juga merupakan salah satu hal yang harus diperhatikan dalam 

mendesain bukaan pada dinding geser. Karena dari beberapa penelitian 

menunjukan bahwa posisi bukaan memiliki pengaruh terhadap kemampuan dinding 

geser dalam menahan gaya lateral. Pada umumnya bukaan-bukaan pada dinding 

geser ditempatkan pada baris vertikal dan simetris pada dinding sepanjang 

ketinggian struktur. 

     Ada berbagai jenis bentuk bukaan pada dinding geser disebabkan oleh 

persayaratan arsitektur dan perencanaan yaitu diantaranya Single Band, Staggred 

Band Openings, Asymmetrical, Two Band, Three Bands, dan Wide Base seperti 

yang ditunjukan pada Gambar 2.9. Bukaan yang terletak dipusat dinding geser lebih 

dianjurkan untuk diterapkan dan dapat meminimalkan penurunan kekuatan dan 

peningkatan deformasi untuk beban yang lebih rendah (Khatami, dkk, 2012) 
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Gambar 2. 4 Bentuk Bukaan Dinding Geser 
Sumber: Paulay & Priestley, 1992 

 

Paling baik bukaan terletak pada pola teratur yang menghasilkan transfer gaya 

yang dapat diprediksi karena bukaan di dinding nantinya akan menggangu aliran 

gaya. Namun terkadang tuntutan perencanaan memerlukan bukaan-bukaan dalam 

pola yang kurang teratur. Hal tersebut harus dihindari bila memungkinkan. Bila 

tidak dapat dihindari, maka memerlukan desain tambahan dan upaya untuk 

meningkatkan kekuatan di sekitar bukaan (Moehle, 2010). 

Pada dasarnya adanya bukaan menyebabkan perubahan distribusi tegangan 

dan penumpukan tegangan yang besar di sudut-sudut bukaan. Terjadinya 

konsentrasi tegangan didaerah bukaan menyebabkan retak pada beton jika tidak 

diberi tulangan (Merryana & Indrawan, 2007).  Oleh karena itu, perlu adanya 

perkuatan pada sekitar bukaan dinding geser yaitu berupa elemen pembatas 

(boundary element).  Berdasarkan SNI 03-2847-2013 dinding geser dengan bukaan 

harus memiliki elemen pembatas khusus pada batas-batas dan tepi-tepi sekeliling 

bukaan dinding struktur di mana tegangan tekan serat terjauh maksimum, terkait 

dengan kombinasi beban termasuk pengaruh gempa, melebihi 0,2𝑓′𝑐. Elemen 
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pembatas khusus diizinkan untuk dihentikan di mana tegangan tekan yang dihitung 

kurang dari 0,15𝑓′𝑐. 

 

 

 

 

 

Gambar 2.5 Elemen Pembatas (Boundary Element) 
Sumber: Moehle, 2010 

 

2.1.5 Pembebanan Struktur 

Pada perencanaan bangunan bertingkat tinggi, komponen struktur harus 

direncanakan cukup kuat untuk memikul semua beban kerjanya baik yang secara 

langsung maupun tidak langsung mempengaruhi struktur bangunan tersebut. Agar 

struktur bangunan tersebut aman secara konstruksi maka struktur tersebut haruslah 

memenuhi persyaratan dalam peraturan-peraturan pembebanan yang berlaku. Jenis 

beban yang biasa digunakan dalam perencanaan bangunan gedung meliputi beban 

hidup, beban mati, dan beban gempa. 

2.1.5.1 Beban Mati 

Beban mati adalah berat dari semua bagian suatu gedung yang bersifat tetap, 

termasuk segala unsur tambahan, penyelesaian-penyelesaian, mesin-mesin serta 

peralatan tetap yang merupakan bagian bagian yang tidak terpisahkan dari gedung 

itu. Menurut Schueller (2001) Beban mati dapat dinyatakan sebagai beban statis 

yang disebakan oleh berat setiap unsur didalam struktur. Gaya-gaya yang 
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menghasilkan beban mati terdiri dari berat unsur pendukung beban dari bangunan, 

lantai, penyelesaian langit-langit, dinding partisi tetap, penyelesaian fasade, tangki 

simpan, sistem distribusi mekanis dan lain-lain. Gabungan beban semua unsur ini 

menjadikan beban mati dari suatu bangunan. Sesuai dengan SNI 03-1727-2013 

yang termasuk beban mati pada suatu bangunan adalah berat seluruh bahan 

konstruksi bangunan gedung yang terpasang termasuk dinding, lantai, atap, plafon, 

tangga, dan komponen struktural dan arsitektural lainnya. 

Dalam menentukan beban mati untuk perancangan suatu bangunan, harus 

digunakan berat bahan dan konstruksi yang sebenarnya, dengan ketentuan jika tidak 

ada informasi yang jelas, nilai yang harus digunakan adalah nilai yang disetujui 

oleh pihak yang berwenang. Maka, dalam perencanaan beban mati pada suatu 

gedung dapat mengacu pada daftar beban mati yang terdapat dalam SNI 03-1727-

1989 seperti yang ditunjukan pada Tabel 2.6. 

Tabel 2.6 Daftar Beban Mati 

Komponen Gedung Merata 

(kg/m2) 

Adukan, per cm tebal 

- Dari semen 

- Dari kapur, semen merah atau tras 

Aspal, termasuk bahan mineral penambah, 

per cm tebal 

Dinding pasangan bata merah 

- Satu batu 

- Setengah batu 

Dinding pasangan batako 

Berlubang 

- Tebal dinding 20 cm 

- Tebal dinding 10 cm 

 

 

21 

17 

14 

 

 

450 

250 

 

 

200 

120 
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Komponen Gedung Merata 

(kg/m2) 

Tanpa Lubang 

- Tebal dinding 15 cm 

- Tebal dinding 10 cm 

Mekanikal dan elektrikal  

Langit-langit dan dinding 

- Semen asbes, dengan tebal 

maksimum 4 mm 

- Kaca, dengantebal 3-5 mm 

- Palfond dan penggantung 

Penutup lantai dari ubin semen Portland, 

teraso dan beton, tanpa adukan, per cm tebal 

geranit 

 

300 

200 

25 

 

11 

 

10 

18 

24 

 

Sumber: SNI 03-1727-1989 

2.1.5.2 Beban Hidup 

Berdasarkan SNI 03-1727-2013 beban hidup didefinisikan sebagai beban 

yang diakibatkan oleh pengguna dan penghuni bangunan gedung atau struktur lain 

yang tidak termasuk beban konstruksi dan beban lingkungan, seperti beban angin, 

beban hujan, beban gempa, beban banjir, atau beban mati. Beban-beban ini 

mencakup berat manusia, perabot, perlengkapan mekanis, kendaraan bermotor, 

perlengkapan industri dan beban sementara lainnya yang berpengaruh terhadap 

sitem bangunan, tetapi bukan bagian dari struktur dan tidak dianggap sebagai beban 

mati. 

Beban hidup berbeda dengan beban mati karena sifatnya yang berubah-ubah 

dan sulit diprakirakan. Perubahan ini bisa berjangka pendek maupun ataupun 

jangka panjang sehingga menjadi hampir mustahil untuk memprakirakan beban-

beban hidup secara statis (Schueller, 2001). 
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Sebelumnya beban hidup juga telah diatur dalam SNI-03-1727-1989. Besaran 

nilainya tergantung akan fungsi setiap lantai gedung seperti yang ditunjukan pada 

Tabel 2.7. 

Tabel 2.7 Beban Hidup Pada Lantai Gedung SNI-03-1727-1989 

 Fungsi Lantai Beban 

A Lantai dan tangga rumah tinggal, kecuali yang 

disebut dalam b 

200 kg/m2 

B Lantai dan tangga rumah tinggal sederhana dan 

gudang-gudang tidak penting yang bukan untuk 

took, pabrik atau bengkel 

125 kg/m2 

C Lantai sekolah, ruang kuliah, kantor, toko, 

toserba, restoran, hotel asrama dan rumah sakit 

250 kg/m2 

D Tangga, bodres tangga dan gang dari yang 

disebut dalam c 

300 kg/m2 

E Lantai gedung parkir bertingkat: 

- Untuk lantai bawah 

- Untuk lantai tingkat lainnya 

 

800 kg/m2 

400 kg/m2 

Sumber: SNI 03-1727-1989 

 

  Namun melalui pengalaman, penyelidikan dan analisis nilai beban yang 

dianjurkan untuk berbagai penggunaan telah dikembangkan dan ditentukan. 

Hasilnya dalam bentuk daftar tabel beban yang dimuat dalam persyaratan bangunan 

dan berisi faktor empiris yang sesuai untuk mengimbangi besar beban maksimum 

yang ditentukan. Hal tersebut dapat dilihat pada Tabel 2.8 berupa daftar beban 

hidup yang ditentukan dalam SNI 03-1727-2013 yang mengatur tentang beban 

minimum untuk perancangan bangunanan gedung dan struktur lain.  
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Tabel 2.8 Daftar Beban Hidup SNI 03-1727-2013 

Hunian atau Penggunaan Merata 

Psf (kN/m2) 

Apartemen dan hotel 

Ruang pribadi 

Ruang publik & koridor 

 

40 (1,92) 

100 (4,79) 

Rumah sakit 

Ruang operasi, laboratorium 

Ruang pasien 

Koridor di atas lantai pertama 

 

60 (2,87) 

40 (1,92) 

80 (3,83) 

Perpustakaan 

Ruang baca 

Ruang penyimpanan 

Koridor di atas lantai pertama 

 

60 (2,87) 

150 (7,18) 

80 (3,83) 

Pabrik 

Ringan 

Berat 

 

125 (6,00) 

250 (11,97) 

Gedung perkantoran 

Lobi dan koridor lantai pertama 

Kantor 

Koridor di atas lantai pertama 

 

100 (4,79) 

50 (2,40) 

80 (3,83) 

Tempat rekreasi 

Tempat bowling, kolam renang 

Ruang dansa 

Gymnasium 

Tempat menonton baik terbuka atau tertutup 

Stadium dan tribun dengan tempat duduk terikat 

 

75 (3,59) 

100 (4,79) 

100 (4,79) 

100 (4,79) 

60 (2,87) 

Atap 

Atap datar, berbubung, dan lengkung 

Atap digunakan untuk taman atap 

 

20 (0,96) 

100 (4,79) 

Sekolah 

Ruang kelas 

Koridor di atas lantai pertama 

Koridor lantai pertama 

 

40 (1,92) 

80 (3,83) 

100 (4,79) 

Sumber: SNI 03-1727-2013 

 

2.1.5.3 Beban Gempa 

Beban gempa adalah beban statik ekivalen yang bekerja dalam gedung atau 

bagian gedung yang menirukan pengaruh dari gerakan tanah akibat gempa, maka 
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yang diartikan dengan gempa disini ialah gaya-gaya di dalam struktur tersebut yang 

terjadi oleh gerakan tanah akibat gempa. 

Berdasarkan SNI 03-1726-2012 analisis beban gempa dapat dilakukan 

dengan 3 prosedur yaitu analisis gaya lateral ekivalen, analisis spektrum ragam, dan 

prosedur riwayat respon seismik. 

1. Analisis Gaya Lateral Ekivalen 

Suatu cara analisis statik struktur, di mana pengaruh gempa pada struktur 

dianggap sebagai beban-beban statik horizontal untuk menirukan pengaruh 

gempa yang sesungguhnya akibat gerakan tanah. Metode analisis statik 

ekivalen merupakan penyederhanaan dari analisis dinamik. Beban gempa 

yang bekerja diasumsikan sebagai beban titik yang bekerja pada tiap lantai 

(Suharjanto, 2013). Untuk struktur gedung sederhana dan beraturan dapat 

digunakan metode ini dalam penentuan beban gempa. 

2. Analisis Spektrum Respon Ragam 

Merupakan suatu analisis dengan menentukan respon dinamik struktur 

gedung yang berperilaku elastis penuh terhadap pengaruh suatu gempa. 

Metode ini merupakan suatu pendekatan terhadap beban gempa yang 

mungkin terjadi. Menurut SNI 03-1726-2012 respon spektrum adalah suatu 

diagram hubungan antara percepatan respon maksimum suatu sistem satu 

derajat kebebasan (SDK) akibat gempa tertentu, sebagai fungsi dari faktor 

redaman dan waktu getar alami. 

3. Prosedur Riwayat Respon Seismik 

Merupakan suatu cara analisa dinamik struktur, di mana suatu model 

matematik dari struktur dikenakan riwayat waktu dari gempa-gempa hasil 
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pencatatan atau gempa-gempa tiruan terhadap riwayat waktu dari respon 

struktur ditentukan. 

Penentuan prosedur analisis yang dapat digunakan tergantung pada kategori 

desain seismik struktur, sistem struktur, properti dinamis, dan keteraturan. 

Ketentuan prosedur analisis yang diizinkan dapat dilihat pada Tabel 2.9. 

Tabel 2. 9 Prosedur Analisa yang Boleh digunakan 

Kategori 

desain 

seismic 

Karakteristik struktur 

Analisis 

gaya 

lateral 

ekivalen 

Analisis 

spektrum 

respon 

ragam 

Prosedur 

riwayat 

respon 

seismic 

B,C Bangunan dengan Kategori Risiko I 

atau II dari konstruksi rangka ringan 

dengan ketinggian tidak melebihi 3 

tingkat 

I I I 

Bangunan lainnya dengan Kategori 

Risiko I atau II, dengan ketinggian 

tidak melebihi 2 tingkat 

I I I 

Semua struktur lainnya I I I 

D, E, F Bangunan dengan Kategori Risiko I 

atau II dari konstruksi rangka ringan 

dengan ketinggian tidak melebihi 3 

tingkat 

I I I 

Bangunan lainnya dengan Kategori 

Risiko I atau II, dengan ketinggian 

tidak melebihi 2 tingkat 

I I I 

Struktur beraturan dengan T< 3,5Ts 

dan semua struktur dari konstruksi 

rangka ringan 

I I I 

Struktur tidak beraturan dengan T< 

3,5Ts dan mempunyai hanya 

ketidakberatran horizontal Tipe 2, 3, 

4, atau 5 dari Tabel 10 atau 

ketidakberaturan vertikal Tipe 4, 5s, 

atau 5b dari Tabel 11 

I I I 

Semua struktur lainnya TI I I 

Catatan: I: Diijinkan, TI: Tidak Diijinkan 

Sumber: SNI 03-1726-2012 
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2.1.5.4 Kombinasi Pembebanan 

     Berdasarkan SNI 03-1727-2013 telah ditentukan bahwa struktur, komponen, 

dan fondasi suatu bangunan dirancang sedemikian rupa sehingga kekuatan 

desainnya sama atau melebihi efek dari beban terfaktor dalam kombinasi berikut: 

1. 1,4D 

2. 1,2D + 1,6L + 0,5 (Lr atau S atau R ) 

3. 1,2D + 1,6 (Lr atau S atau R ) + (L atau 0,5W ) 

4. 1,2D + 1,0W + L + 0,5 (Lr atau S atau R ) 

5. 1,2D + 1,0E + L + 0,2S  

6. 0,9D + 1,0W 

7. 0,9D + 1,0E 

Keterangan: 

D = beban mati 

L  = beban hidup 

E = beban gempa 

W = beban angin 

Lr = beban hidup atap 

R = beban hujan 

S = beban salju 

 

Pengaruh beban gempa (E) harus ditentukan sesuai dengan kriteria berikut ini: 

1. Untuk penggunaan dalam kombinasi beban 5 atau kombinasi beban 5 dan 

6, nilai E harus ditentukan sesuai dengan persamaan: 

𝐸 =  𝐸ℎ + 𝐸𝑣            (2.6) 

2. Untuk penggunaan dalam kombinasi beban 7 atau kombinasi beban 8, nilai 

E harus ditentukan sesuai dengan persamaan berikut: 

𝐸 =  𝐸ℎ + 𝐸𝑣            (2.7) 
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Keterangan: 

E = pengaruh beban gempa 

Eh = pengaruh beban gempa horizontal 

Ev = pengaruh beban gempa vertikal 

 

Pengaruh beban gempa horizontal (Eh) harus ditentukan sesua dengan persamaan 

berikut: 

              𝐸ℎ =  𝜌𝑄𝐸                    (2.8)  

Keterangan: 

  QE = pengaruh gaya gempa horizontal dari V atau Fp 

𝜌 = faktor redudansi 

 

Pengaruh beban gempa vertikal (Ev) harus ditentukan sesuai dengan persamaan 

berikut: 

              𝐸𝑣 = 0,2 𝑆𝐷𝑆 𝐷           (2.9) 

Keterangan: 

𝑆𝐷𝑆 = parameter percepatan spektrum respon desain pada perioda  

    pendek 

D = beban mati 

 

     Berdasarkan SNI-03-1726-2012 struktur bangunan  yang berfungsi untuk 

menahan gaya lateral, perlu direncanakan kekuatanyya terhadap pengaruh 100% 

dari beban gempa dalam arah sumbu utama bangunan, dikombinasikan dengan 

pengaruh 30% dari beban gempa dalam arah tegak lurus padanya. Sehingga 

kombinasi pembebanan menjadi sebagai berikut: 

1. 1,4D 

2. 1,2D + 1,6L 

3. 1,2D + 1,0L ± 0,3 ( 𝜌𝑄𝐸𝑥 + 0,2𝑆𝐷𝑆 𝐷 ) ± 1,0 ( 𝜌𝑄𝐸𝑦 + 0,2𝑆𝐷𝑆 𝐷 ) 

4. 1,2D + 1,0L ± 1,0 ( 𝜌𝑄𝐸𝑥 + 0,2𝑆𝐷𝑆 𝐷 ) ± 0,3 ( 𝜌𝑄𝐸𝑦 + 0,2𝑆𝐷𝑆 𝐷 ) 

5. 0,9D ± 0,3 ( 𝜌𝑄𝐸𝑥 − 0,2𝑆𝐷𝑆 𝐷 ) ± 1,0 ( 𝜌𝑄𝐸𝑦 − 0,2𝑆𝐷𝑆 𝐷 ) 

6. 0,9D ± 1,0 ( 𝜌𝑄𝐸𝑥 − 0,2𝑆𝐷𝑆 𝐷 ) ± 0,3 ( 𝜌𝑄𝐸𝑦 − 0,2𝑆𝐷𝑆 𝐷 ) 
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2.1.6 Metode Analisa Respon Spektrum 

Berdasarkan SNI 03-1726-2012 respon spektrum adalah suatu diagram 

hubungan antara percepatan respon maksimum suatu sistem satu derajat kebebasan 

akibat gempa tertentu, sebagai fungsi dari faktor redaman dan waktu getar alami. 

Absis dari grafik tersebut berupa frekuensi (periode/waktu) dan ordinat berupa nilai 

respon maksumum. 

SNI 03-1726-2012 telah mengatur beberapa tahapan dalam mendesain respon 

spectrum dengan menghitung persamaan-persamaan sesuai dengan periode. 

Berikut ini tahapan-tahapan dalam mendesain respon spectrum:  

1. Menghitung parameter spektrum respon percepatan pada perioda pendek 

(𝑆𝑀𝑆) dan perioda 1 detik ((𝑆𝑀1) yang disesuaikan dengan pengaruh 

kelasifikasi situs, dan dapat ditentukan dengan persamaan (2.10) dan (2.11) 

𝑆𝑀𝑆 =  𝐹𝑎 𝑥 𝑆𝑆         (2.10) 

𝑆𝑀𝑆 =  𝐹𝑣 𝑥 𝑆1         (2.11) 

2. Untuk nilai 𝑆𝑆 (percepatan batuan dasar pada perioda 0,2 detik) dan 𝑆1 

(percepatan batuan dasar pada perioda 1 detik) dapat ditetapkan berdasarkan 

peta gerak tanah seismic yang ditunjukan pada Gambar 2.1 dan Gambar 2.2. 

sedangkan faktor amplikasi getaran (𝐹𝑎 dan 𝐹𝑣) dapat ditentukan 

berdasarkan tabel 2.10 dan 2.11. 
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Tabel 2.10 Koefisien Situs, 𝑭𝒂 

Kelas 

situs 

Parameter respon spectral percepatan gempa (MCER) 

terpetakan pada perioda pendek, T=0,2 detik, 𝑺𝑺 

 𝑆𝑆 ≤ 0,25 𝑆𝑆 = 0,5 𝑆𝑆 = 0,75 𝑆𝑆 = 1,0 𝑆𝑆 ≥ 1,25 

SA 0,8 0,8 0,8 0,8 0,8 

SB 1,0 1,0 1,0 1,0 1,0 

SC 1,2 1,2 1,1 1,0 1,0 

SD 1,6 1,4 1,2 1,1 1,0 

SE 2,5 1,7 1,2 0,9 0,9 

SF SSb 
Catatan: 

(a) Untuk nilai-nilain antara 𝑆𝑆dapat dilakukan interpolasi linier 

(b) SS = Situs yang memerlukan investigasi geoteknik spesifikasi dan analisis respon 

situs-spesifik 

Sumber: 03-1726-2012 

 

Tabel 2.11 Koefisien Situs, 𝑭𝒗 

Kelas 

situs 

Parameter respon spectral percepatan gempa (MCER) 

terpetakan pada perioda pendek, T=0,2 detik, 𝑺𝑺 

 𝑆𝑆 ≤ 0,1 𝑆𝑆 = 0,2 𝑆𝑆 = 0,3 𝑆𝑆 = 0,4 𝑆𝑆 ≥ 0,5 

SA 0,8 0,8 0,8 0,8 0,8 

SB 1,0 1,0 1,0 1,0 1,0 

SC 1,7 1,6 1,5 1,4 1,3 

SD 2,4 2 1,8 1,6 1,5 

SE 3,5 3,2 2,8 2,4 2,4 

SF SSb 
Catatan: 

(c) Untuk nilai-nilain antara 𝑆𝑆dapat dilakukan interpolasi linier 

(d) SS = Situs yang memerlukan investigasi geoteknik spesifikasi dan analisis respon 

situs-spesifik 

Sumber: 03-1726-2012 

 

 

 Menurut SNI 03-1726-2013, kelas situs adalah klasifikasi situs yang 

dilakukan berdasarkan kondisi tanah dilapangan. Tipe kelas situ dapat 

ditentukan dengan beberapa ketentuan yang dapat dilihat pada Tabel 2.12. 
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Tabel 2.12 Klasifikasi Situs 

Kelas Situs Vs(m/detik) N atau Nch Su (kPa) 

SA (batuan keras) >1500 N/A N/A 

SB (batuan) 750 sampai 1500 N/A N/A 

SC (tanah keras) 350 sampai 750 >50 ≥100 

SD (tanah sedang) 175 sampai 350 15 sampai 50 50 sampai 100 

SE (tanah lunak) <175 <15 <50 

Atau setiap profil tanah yang mengandung lebih dari 

3 m tanah dengan karakteristik sebagai berikut: 

1. Indeks plastisitas, PI > 20, 

2. Kadar air, w ≥ 40 %, 

3. Kuat geser niralir Su < 25 kPa 

SF (tanah khusus 

yang 

membutuhkan 

investigasi 

geoteknik spesifik 

dan analisis 

respon spesifik-

situs) 

Setiap profil lapisan tanah yang memiliki salah satu 

atau lebih dari karakteristik berikut: 

- Rawan dan berpotensi gagal atau runtuh 

akibat beban gempa seperti mudah likuifaksi, 

lempung sangat sesnsitif, tanah tersementasi 

lemah 

- Lempung sangat organic dan/atau gambut 

(ketebalan H > 3 m) 

- Lempung berplastisitas sangat tinggi 

(ketebalan H > 7,5 m dengan Indeks 

Plastisitas PI > 75) 

Lapisan lempung lunak/setengah teguh dengan 

ketebalan H > 35 m dengan Su < 50 kPa 
N/A = tidak dapat dipakai 

Sumber: 03-1726-2012 

3. Menghitung parameter percepatan spektral desain untuk perioda pendek 

(𝑆𝐷𝑆) dan pada periodan 1 detik (𝑆𝐷1). Keduanya dapat ditentukan melalui 

persamaan 2.12 dan 2.13. 

𝑆𝐷𝑆 =  
2

3
𝑆𝑀𝑆         (2.12) 

𝑆𝐷1 =  
2

3
𝑆𝑀1           (2.13) 

4. Setelah menghitung parameter percepatan spektral desain, lanjutkan dengan 

membuat kurva spektrum respon seperti yang ditunjukan pada Gambar 2.11 

dan mengikuti ketentuan dibawah ini: 
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a. Untuk perioda yang lebih kecil dari T0, spectrum respon percepatan 

desain, Sa, didapatkan dengan menggunakan persamaan 2.14. 

 𝑆𝑎 =  𝑆𝐷𝑆 (0,4 + 0,6
𝑇

𝑇0
)       (2.14) 

b. Untuk perioda lebih besar dari atau sama dengan T0 dan lebih kecil dari 

atau sama dengan Ts, spectrum respon percepatan desain, Sa, sama 

dengan 𝑆𝐷𝑆 

c. Untuk perioda lebih besar dari Ts, spectrum percepatan desain, Sa, 

diambil berdasarkan persamaan 2.15. 

𝑆𝑎 =  
𝑆𝐷𝑆

𝑇
         (2.15) 

Keterangan: 

𝑆𝐷𝑆 = parameter respon spectral percepatan desain pada perioda 

pendek 

𝑆𝐷1 = parameter respon spectral percepatan desain pada perioda 1 

detik 

T     = perioda getar fundamental struktur 

T0    = 0,2 
𝑆𝐷1

𝑆𝐷𝑠
 

Ts      = 
𝑆𝐷1

𝑆𝐷𝑠
 

 

 

 

 

Gambar 2.6 Kurva Respon Spektrum  
Sumber: 03-1726-2012 
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2.1.7 Software ETABS 

Untuk memudahkan proses perencanaan ataupun analisa suatu bangunan 

dapat digunakan berbagai software penunjang yang memungkinkan untuk 

memodelisasikan bangunan kedalam komputer. Pada modelisasi bangunan tersebut 

nantinya akan diberikan faktor-faktor kombinasi beban yang mungkin akan 

diterima bangunan dan berpengaruh terhadapnya, misalnya beban gempa. Ini 

bertujuan untuk mengetahui respon atau perilaku bangunan tersebut terhadap 

berbagai macam kombinasi tersebut . Hal ini sangat penting dilakukan sebagai tolak 

ukur kelayakan bangunan tersebut. Banyak software-software penunjang yang kini 

telah berkembang yang dapat digunakan untuk menunjang proses analisa suatu 

bangunan diantaranya adalah SAP2000, STAADpro, ANSYS mechanical, ETABS, 

dan sebagainya.  

Program ETABS merupakan salah satu program analisa struktur yang 

dikembangkan oleh perusahaan Software Computers and Structure, Incorporated 

(CSI) yang dasar analisanya berbasis pada Metode Elemen Hingga (Finite Element 

Methode) dalam pemecahan masalah statistika dan mekanikanya dengan tujuan 

khusus untuk mendesain bangunan dan menganalisis sistem bangunan struktur. 

Konsep dasar ETABS adalah perancangan hanya membuat model yang terdiri dari 

sistem lantai, sistem rangka vertikal dan horizontal untuk menganalisis dan 

mendesain keseluruhan bangunan (Computer and Structures Inc, 2002). 

Program ETABS merupakan salah satu program yang dikhususkan untuk 

menganalisa struktur high-rise building. Program ini secara khusus difungsikan 

untuk menganalisa beberapa jenis perencanaan struktur seperti frame baja, frame 
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beton, balok komposit, baja rangka batang, dan analisis dinding geser. Penggunaan 

program ini dalam menganalisis struktur terutama untuk bangunan tinggi sangat 

tepat bagi perencana struktur karena beberapa faktor yaitu dari segi ketepatan dari 

output yang dihasilkan dan efektif waktu yang digunakan dalam menganalisanya 

(Pamungkas, 2009). 

Adapun secara umum langkah-langkah dalam proses pemodelan dan analisis 

struktur dengan software ETABS adalah sebagai berikut: 

1. Definisi grid dan story data pilih File > New Model > No sehingga muncul 

kotak dialog “Building Plan Grid System and Story Definition” lalu pilih Grid 

only pada structural object. Setelah itu masukan data grid dan story 

dimension yang akan dibuat untuk membantu proses pemodelan bangunan 

kemudian klik ok.  

2. Input data material dengan klik Define > Material Propertise > Add New 

Material kemudian masukan data material yang akan digunakan. 

3. Kemudian define dimensi struktur, untuk komponen balok dan kolom dapat 

dilakukan dengan cara Define > Frame Section . sedangkan untuk pelat dan 

wall dengan cara Define > Wall/Slab/Deck Section.  

4. Menentukan beban yang akan bekerja pada bangunan dengan cara Klik 

Define > Static Load Case kemudian input jenis-jenis beban yang akan 

digunakan untuk proses analisis. 

5. Define respon spektrum sebagai beban gempa dengan cara pilih Define > 

Response Spectrum Function. Pada kotak dialog Define Response Spectrum 

Function, klik Add User Spektrum. Kemudian input data Period dan 
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Acceleration (percepatan gempa) sesuai dengan perhitungan pada kotak 

dialog Respons Spectrum Function Definition lalu klik ok. 

6. Menentukan spektrum gempa. Pilih Define > Respon Spectrum Case setelah 

muncul Define Response Spectra klik Add New Spectrum. Masking data 

panda kotak dialog Response Spectrum, data yang dimasukan seperti 

Spectrum Case Name berupa RSPX dan RSPY. Input Response Spectrume 

untu arah X isikan Function dan Scale Factor pada kotak U1 dan untuk arah 

Y pada kotak U2 sesuai dengan perhitungan. 

7. Menentukan kombinasi pembebanan dengan cara klik Define > Load 

Combination setelah itu muncul kotak dialog Define Load Combination pilih 

Add New Combo kemudian masukan scale factor setiap jenis beban pada 

masing-masing kombinasi yang telah direncanakan sebelumnya. 

8. Menggambar kolom dengan klik menu Draw > Draw Line Object > Draw 

line kemudian tentukan type balok yang akan digunakan. Setelah itu 

gambarkan balok pada garis grid yang telah dibuat sebelumnya. 

9. Menggambar pelat dengan klik menu Draw > Draw Area Object > Draw 

Area kemudian tentukan type pelat yang akan digunakan. Setelah itu 

gambarkan plat sesuai gambar perencanaan. 

10. Menggambar wall dengan klik menu Draw > Draw Area Object > Draw 

Walls (Plan) pada Properties of Object tentukan type wall yang akan 

digunakan. Setelah itu gambarkan wall pada grid yang sudah dibuat sebagai 

acuan pemodelan. 

11. Input beban mati dan beban hidup untuk itu pilih plat yang akan diinput beban 

kemudian pilih menu Assign > Shell/ Area loads > Uniform. Pilih Load Case 
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Name antara Dead/Live disesuaikan dengan jenis beban yang akan 

dimasukan. 

12. Menentukan jenis perletakan pada bagian bawah struktur. Select semua titik-

titik yang berada pada lantai base kemudian pilih menu Assign > Joint/ Point 

> Restraints/Support, pilih jenis support yang akan digunakan lalu klik Ok 

untuk keluar. 

13. Setelah semua pemodelan setiap elemen struktur selesai langkah selanjutnya 

adalah proses analisis dengan klik menu Analyze > Set Analysis Option. 

Setelah muncul kotak dialog Analysis Option pilih Full 3D pada Building 

Active of Freedom dan checklist pada Dynamic Analysis lalu klik Ok. Setelah 

itu klik Analysis lalu Run Analysis. 

2.2 Penelitan yang Relevan 

Beberapa penelitian terdahulu juga telah membahas mengenai peneraapan 

bukaan pada dinding geser dan relevan dengan penelitian. Berikut ini penelitian 

yang dianggap relevan dengan penelitian yang akan diangkat. 

1. Ruchi Sharma dan Jignesh A. Amin (2015) “Effects of opening in shear walls 

of 30-storey building”. 

Penelitian ini dilakukan dengan memodelkan bangunan 30 lantai dan dimensi 

25 m × 25 m. Bangunan didesain menggunakan konstruksi beton bertulang 

memiliki ukuran kolom 900 mm × 900 mm untuk lantai 1-15 dan 600 mm × 

600 mm untuk lantai 16-30 dengan dimensi balok dan ketebalan plat yang 

seragam disetiap lantai. Tinggi masing-masing lantai 3,5 m dan ketebalan 

shear wall 250 mm yang diposisikan di arah X dan arah Y. Pada penelitian 

ini dibuat 6 pemodelan bangunan di mana model I merupakan sistem rangka 



51 

 
 

tanpa shear wall, model II sistem rangka yang menggunakan shear wall, dan 

model III, IV, V, VI merupakan sistem rangka dengan shear wall yang 

memiliki bukaan pada penampangnya dengan beberapa variasi ukuran 

bukaan yaitu 2m × 2,1 m, 2m × 2,8 m, 3 m × 2,1 m, dan 3 m × 2,8 m yang 

semuanya diletakan pada pusat penampang shear wall. 

Kesimpulan dalam penelitian ini bukaan pada dinding geser yang 

menyebabkan volume dinding geser berkurang sehingga dapat mengurangi 

kekakuan bangunan dalam menerima beban lateral serta membuat 

displacement dan inter-story pada bangunan meningkat. Secara keseluruhan  

dibandingkan dengan shear wall tanpa bukaan displacement meningkat mulai 

dari 0,58% sampai 20,95% dan inter-story meningkat mulai dari 1,04% 

samapai 23,63% tergantung besar ukuran bukaan. 

2. Seyed M.Khatami, Alireza Mortezaei, dan Rui C. Barros (2012) “Comparing 

Effect of Opening in Concrete Shear walls Under Near-Fault Ground 

Motions”. 

Penelitian ini menggunakan bangunan 10 lantai dengan ketinggian setiap 

lantainya 3 m, dengan bentuk persegi panjang yang terdiri dari 5 bentang 

dengan jarak 5 m pada arah X dan 3 bentang dengan jarak 4 meter pada arah 

Y. Bangunan didesain dengan mutu beton 25 MPa dan mutu besi 400 MPa. 

dinding geser ditempatkan di tengah-tengah bentang arah X. Dinding geser 

dimodelkan menggunakan tiga bentuk yang berbeda. Model pertama yaitu 

shear wall tanpa bukaan, kemudian dua model lainnya shear wall dengan 

bukaan berbentuk persegi yang ditempatkan di pusat dan sisi kanan 

permukaan shear wall. 
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Kesimpulan dalam penelitian ini adanya bukaan pada dinding geser dapat 

menurunkan daya dukung lateral dinding geser. Di mana penurunan terjadi 

sekitar 37% pada shear wall dengan bukaan yang berada di pusat penampang 

dibandingkan dengan shear wall tanpa bukaan. Selain itu, penurunan juga 

terjadi sebesar 54% ketika bukaan diletakan di sisi kanan shear wall. 

Sehingga dianjurkan bukaan berada di pusat penampang dinding geser untuk 

dapat meminimalkan penurunan kekuatan dan peningkatan deformasi untuk 

beban yang lebih rendah. 

3. Pravin D.Dore dan Rajashekhar Talikoti (2015) “Comparative Study of 

Behavior of Shear wall with Different Percentage of Opening”. 

Penelitian dilakukan pada bangunan dengan kontruksi beton bertulang yang 

terdiri dari 12 lantai dan ketinggian antar tingkat seragam yaitu 3,1 meter. 

Dinding geser dan kolom memiliki penampang yang sama diseluruh 

ketinggian. Dinding geser didesain dengan ketebalan 230 mm sedangkan 

penampang kolom didesain dengan ukuran 230 × 975 mm. Selain itu, 

ketebalan slab lantai dan atap adalah 150 mm dan dimensi semua balok  250 

× 600 mm. Pada penelitian ini akan dibuat 6 pemodelan struktur dengan 

beragam variasi ukuran bukaan. Model W1 adalah shear wall tanpa bukaan. 

Model W2 adalah shear wall dengan bukaan (1,0 × 1,2). Model W3 adalah 

shear wall dengan bukaan (1,5 × 1,2). Model W4 adalah shear wall dengan 

bukaan (2,0 × 1,2). Model W5 adalah shear wall dengan bukaan (2,5 × 1,2). 

Model W6 adalah shear wall dengan bukaan (1,0 × 1,2). Nantinya akan 

dilihat perbandingan nilai displacement dan story drift dari keenam model 

menggunakan software ETABS. 
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Kesimpulan dari penelitian ini adalah dari hasil analisa bahwa displacement 

maximum terjadi pada model W6 sekitar 9,5% di arah-x dan 11% diarah-y. 

Jadi, semakin besar bukaan diberikan pada dinding geser maka akan 

meningkatkan displacement bangunan. kemudian dari story drift maksimum 

berada di lantai 5 sekitar 8,9% di arah-X dan di lantai 7 sekitar 14,7% pada 

model W6 jika dibandingkan dengan model W1. Semua model memiliki nilai 

minimum soft storey di lantai 1 dibandingkan dengan model W1. 

2.3 Kerangka Konseptual 

Gempa merupakan getaran yang bersifat alamiah, yang terjadi pada lokasi 

tertentu karena adanya pergerakan kerak bumi (lempeng bumi) secara tiba-tiba baik 

yang disebabkan oleh alam maupun aktivitas manusia. Getaran yang dihasilkan 

disebarkan kesegala arah berupa gelombang sehingga efeknya dapat dirasakan 

sampai ke permukaan bumi yang dapat mengakibatkan berbagai kerusakan salah 

satunya adalah kerusakan konstruksi bangunan. 

Indonesia sebagai negara yang memiliki potensi terjadinya gempa yang 

cukup besar tentunya dalam perencanaan konstruksi bangunan harus direncanakan 

sebagai bangunan tahan gempa. Terutama untuk bangunan-bangunan tinggi yang 

yang memiliki sifat fleksibel sehingga dapat mengalami gaya yang jauh lebih besar 

akibat gerak permukaan yang berulang-ulang disebabkan oleh gempa. Hal tersebut 

dapat diperparah dengan kemungkinan bangunan didesain dengan bentuk yang 

tidak beraturan, baik secara vertikal maupun horizontal. Hal ini akan menjadikan 

bangunan memiliki potensi bahaya yang lebih besar terhadap beban gempa. Oleh 

karena itu, dalam mendesain suatu bangunan tahan gempa salah satu solusi yang 
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dapat digunakan adalah perlu adanya elemen-elemen pengaku yang dapat 

meningkatkan kinerja bangunan dalam menahan beban gempa. 

Dinding geser merupakan salah satu elemen pengaku berupa dinding beton 

bertulang dengan kekakuan bidang datar yang sangat besar sehingga efektif dalam 

menahan beban lateral termasuk gempa. Namun, penerapan dinding geser pada 

bangunan-bangunan tinggi seperti apartemen, hotel, kantor, dan sebagainya 

terkadang mengharuskan dinding geser memiliki bukaan pada penampangnya 

untuk alasan peemenuhan kebutuhan ruangan dan estetika. Secara teori adanya 

bukaan pada dinding geser ini dapat mempengaruhi kinerja dinding geser dalam 

menahan gaya lateral. Hal ini dikarenakan adanya bukaan menyebabkan terjadinya 

konsentrasi tegangan dan pergeseran lateral lokal yang mungkin sulit diukur dan 

disesuaikan dalam desain, dalam beberapa kasus menyebabkan respon seimik yang 

tidak diinginkan. 

Meskipun demikian, biasanya dengan ukuran dan posisi tertentu bukaan tidak 

akan memiliki pengaruh yang signifikan terhadap kemampuan dinding geser dalam 

menahan beban lateral. Oleh karena itu maka dirasa perlu dilakukan penelitian 

mengenai variasi bukaan dinding geser untuk mendapatkan ukuran dan posisi 

bukaan yang optimal dalam menahan beban lateral. 

2.4 Hipotesis Penelitian 

Berdasarkan teori yang telah dibahas sebelumnya, maka dapat dirumuskan 

hipotesis dalam penelitian ini adalah sebagai berikut: 

Diduga shear wall dengan ukuran bukaan yang kecil dan posisi di pusat 

penampang shear wall akan menghasilkan respon bangunan yang lebih baik dan 

tidak secara signifikan berpengaruh pada kinerja bangunan terhadap beban gempa.
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BAB III 

METODOLOGI PENELITIAN 

 

3.1 Tempat, Waktu dan Subjek Penelitian 

Tempat, waktu dan subjek yang digunakan untuk melakukan penelitian ini 

adalah sebagai berikut: 

1. Waktu penelitian 

Waktu yang digunakan untuk melakukan penelitian ini mulai dari 

penyusunan proposal sampai dengan penyusunan laporan penelitian adalah 

pada bulan Februari sampai dengan Agustus 2017. 

2. Objek penelitian 

Objek yang digunakan pada penelitian ini adalah bukaan dinding geser yang 

diterapkan pada bangunan Apartemen Bassura City Tower Jasmine. 

3.2 Deskripsi Bangunan 

Bangunan Apartemen Bassura City ini merupakan bangunan dengan dua 

tower yaitu tower Heliconia dan Jasmine yang memiliki basement menyatu. Namun 

pada dasarnya bangunan tersebut tidak merupakan satu kesatuan karena terdapat  

sistem pemisah late pour strip diantara kedua pelat basement yang menyatu tersebut 

seperti yang ditunjukan pada Gambar 3.1.  

Sehingga, yang akan jadi fokus subjek dalam penelitian ini hanya salah satu 

tower saja yaitu pada tower Jasmine yang memiliki bukaan pada shear wallnya. 

Bangunan  termasuk dalam kategori bangunan tinggi dengan ketidakberaturan 

seperti yang ditunjukan pada Gambar 3.2. Semua komponen strukturnya didesain 

menggunakan konstruksi beton bertulang. 
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Gambar 3.1 Denah Bangunan Apartemen Bassura City 
Sumber : Dokumen Proyek 

 

 

 

 

 

 

 

 

 

 

 

Gambar 3.2 Denah Bangunan Apartemen Bassura City Tower Jasmine 
Sumber : Dokumen Proyek 
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Gambar 3.3 Tampak Depan Apartemen Bassura City Tower Jasmine 
Sumber : Dokumen Proyek 

 

Adapun data-data teknis yang digunakan dalam proses analisis adalah 

sebagai berikut: 

1. Lokasi bangunan : Jalan Basuki Rahmat No.1A, Jakarta Timur 

2. Fungsi bangunan : Apartemen 

3. Kategori resiko : II 

4. Konstruksi Bangunan : Struktur beton bertulang 

5. Jenis tanah  : Tanah sedang (SD) 

6. Jumlah lantai  : 21 Lantai, 1 Ground Floor, 1 Lower Ground, 

       dan 2 Basement 

7. Ketinggian lantai : 

B1 dan B2  : 3,2 m 

Lower Ground  : 3,55 m 
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Ground Floor  : 3,22 m 

Lt.1   : 3,2 m 

Lt.2 s/d Lt.25  : 2,7 m 

Lt.25-Lt.Atap  : 2,75 m 

8. Spesifikasi material  : 

Mutu beton : 

- Kolom/ Shear wall : Lt.Basement 2 s/d Lt.6 = K 450 (f’c = 37,35 Mpa) 

   (Kecuali K3J K 400) 

 : Lt.7 s/d Lt.19      = K 400 (f’c = 33,20 Mpa) 

 : Lt.20 s/d Lt.Atap      = K 350 (f’c = 29,05 Mpa) 

 

- Balok/ Pelat  : Lt.Basement 2 s/d Lt.6 = K 350 (f’c = 29,05 Mpa) 

 : Lt.7 s/d Lt.19      = K 350 (f’c = 29,05 Mpa) 

 : Lt.20 s/d Lt.Atap      = K 300 (f’c = 24,90 Mpa) 

 Mutu besi beton : 

 BJTD 40  : fy = 400 MPa 

9. Dimensi struktur 

Dimensi kolom, balok, plat dan dinding geser yang digunakan sesuai 

dengan yang digunakan pada bangunan eksisting.  

a. Konstruksi Kolom 

Terdapat 3 tipe kolom yang digunakan pada bangunan ini yaitu K1J, 

K2J, K3J, dan KL. Dimensi kolom beragam disetiap jenis dan beberapa 
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lantai. Macam-macam dimensi kolom pada bangunan apartemen 

Bassura City Tower Jasmine dapat dilihat pada Tabel 3.1.  

Tabel 3.1 Tipe Kolom 

Lantai K1J K2J K3J KL 

Lt.20 – 

Lt.Atap 

450 × 600 450 × 600  200 × 400 

Lt.12 – 

Lt.19 

450 × 700 450 × 700  200 × 400 

Lt.7 – Lt.11 450 × 800 450 × 800  200 × 400 

Lt.1 - Lt.6 450 × 900 450 × 900  200 × 400 

Bassement 2 

– Lt.Dasar 

450 × 1000 450 × 1000 600 × 600 200 × 400 

                     Sumber : Dokumen Proyek 

b. Konstruksi Balok 

Tabel 3.2 Tipe Balok 

 

TIPE UKURAN Lantai TIPE UKURAN Lantai 

G24 200 × 400 
B1 

B24 200 × 400 
B1-

Lt.Atap 

G59 500 × 900 B24A 200 × 450 

GF 
G35 300 × 500 

B1-

Lt.Atap 
B25 200 × 500 

G36 300 × 600 

B1-GF 

B2A4A 250 × 450 
Lt.1-

Lt.Atap 
G37 300 × 700 B34 300 × 400 

G38 300 × 800 B34A 300 × 450 

G3A7 350 × 700 B35 300 × 500 

B1-GF G47 400 × 700 B36 300 × 600 

G46 400 × 700 

GF 

B37 300 × 700 

G48 400 × 800 B43A 400 × 350 
Lt.1-

Lt.Atap 

G58 500 × 800 B46 400 × 600 

B1 

G66 600 × 600 B47 400 × 700 

G68 600 × 800 B48 400 × 800 

G44A 400 × 450 

Lt.1-

Lt.Atap 

B4A8 450 × 800 

G45 400 × 500 B59 500 × 900 

G72 700 × 200    

G34 300 × 400 CG35 300 × 500 
GF-

Lt.Atap 

G34A 300 × 450    
                  Sumber : Dokumen Proyek 
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c. Konstruksi Pelat 

Tabel 3.3 Tipe Pelat 

TIPE KETEBALAN Lantai 

S12 120 mm B1 dan LG 

S13 130 mm Lt.1-Lt.Atap 

S14 140 mm B1 dan LG 

S15 150 mm Lt.1-Lt.Atap 

S18 180 mm Lt.1 

S20 200 mm B1-Lt.Atap 
                                    Sumber : Dokumen Proyek 

d. Konstruksi Dinding Geser 

Shear wall merupakan elemen struktur bangunan berbentuk dinding 

beton bertulang yang menerus dari dasar sampai puncak bangunan yang 

berfungsi sebagai pengaku bangunan terhadap gaya lateral. Pada 

bangunan ini shear wall dibagi menjadi 3 tipe dengan dimensi yang 

berbeda seperti yang ditunjukan pada Tabel 3.4. selain itu penempatan 

shear wall dari masing-masing tipe juga beragam ada yang berada di sisi 

luar bangunan dan juga ada yang berada di dalam bangunan seperti yang 

ditunjukan pada Gambar 1.1 (a). Khusus pada semua shear wall tipe 

W1J terdapat bukaan pada penampangnya yang diterapkan mulai dari 

lantai 1 sampai dengan lantai 21 dengan ukuran 600 x 1310 mm dan 

posisi seperti yang ditunjukan pada Gambar 1.1 (b)  

Tabel 3.4 Tipe Shear wall 

TIPE KETEBALAN 

W1J 350 mm 

W2J 350 mm 

W3J 300 mm 
                                    Sumber : Dokumen Proyek 
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3.2.1 Deskripsi Ketidakberaturan Bangunan Tower Jasmin 

Sesuai dengan penjelasan pada sub bab sebelumnya pada penelitian ini 

dilakukan analisa pemodelan pada bangunan Apartemen Bassura City Tower 

Jamine yang secara denah memiliki ketidakberaturan sudut seperti yang ditunjukan 

pada Gambar 3.4 terlihat kedua proyeksi denah struktur dari sudut dalam lebih besar 

dari 15 persen dimensi denah struktur dalam arah yang ditentukan. Dimana 

ketidakberaturan pada arah X sebesar 47,97% dan untuk arah Y sebesar 29,29%. 

𝜌𝑥 > 0,15𝑙𝑥 

14750 > 0,15(28350) 

14750 > 4252,5 

 

𝜌𝑦 > 0,15𝑙𝑦 

37600 > 0,15(53175) 

37600 > 7976,25 

 

 

 

Gambar 3.4. Ketidakberaturan Sudut Bangunan 
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 Selain itu bangunan ini juga memiliki ketinggian lantai yang beragam 

dimana perbedaan yang cukup besar berada pada lantai 1 dan 2. Maka dilakukan 

perhitungan kekakuan kolom dari kedua lantai untuk memastikan terjadinya 

fenomena soft story pada lantai tersebut. Adapun perhitungan kekakuan dari 

masing-masing lantai adalah sebagai berikut:  

 Lantai 1 

Elastisitas beton (E) : 20000000 kN/m2 

Dimensi kolom  : 450 x 900   

Tinggi kolom (l)  : 3,2 m 

Inersia Kolom (I) 

I1 : 
1

12
 × b × h3  

   
1

12
 × 0,45 × 0,93 = 0,027 m4 

Kekakuan Kolom (k) 

k = 
12 𝐸𝐼

𝑙3  = 
12 .  20000000 .  0,027

3,23  = 197753,90 kN/m 

Total kekakuan kolom = 46 × (197753,90) = 9096679,40 kN/m 

 

 Lantai 2 

Elastisitas beton (E) : 20000000 kN/m2 

Dimensi kolom  :  K1 : 450 x 900   

Tinggi kolom (l)  :  2,7 m 

Inersia Kolom (I) 

I1 : 
1

12
 × b × h3  

    
1

12
 × 0,45 × 0,93 = 0,027 m4 
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Kekakuan Kolom (k) 

k1 = 
12 𝐸𝐼

𝑙3  = 
12 .  20000000 .  0,027

2,73  = 329218,11 kN/m 

Total kekakuan kolom = 46 × (329218,11) = 15144033,06 kN/m 

 

9096679,40 < 70% (15144033,06) 

9096679,40 < 10600823,14 

Sesuai dengan ketentuan SNI-03-1726-2013 bangunan dengan 

ketidakberaturan kekakuan tingkat (soft story) jika terdapat suatu tingkat di mana 

kekakuan lateralnya kurang dari 70 persen kekakuan lateral tingkat di atasnya.  

Maka dari hasil diatas terlihat bahwa bangunan Apartemen Bassura City Tower 

Jasmine juga memiliki ketidakberaturan kekakuan tingkat (soft story). 

 

3.3 Perlakuan Penelitian 

Fokus penelitian ini adalah pada shear wall Tipe W1J yang berada di sisi luar 

bangunan seperti yang ditunjukan pada Gambar 3.5. Di mana nantinya pada shear 

wall tipe ini akan dibuat beberapa variasi pemodelan mulai dari tanpa bukaan dan 

adanya bukaan dengan beragam variasi ukuran dan posisi dengan Model 2 

merupakan bentuk bukaan eksisting seperti pada Gambar 3.6. Hal ini dilakukan 

dengan pertimbangan bahwa secara teori ukuran dan posisi bukaan pada shear wall 

akan berpengaruh pada kinerjanya. Bukaan hanya akan diterapkan pada lantai 1 

sampai dengan 25 saja sesuai dengan eksisting. 
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Gambar 3.5 Denah Shear wall Tipe W1J 
Sumber : Dokumen Proyek 
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Gambar 3.6 Variasi Pemodelan Bukaan Shear wall 

 

 

3.4 Analisa Pembebanan 

Pembebanan yang digunakan untuk proses analisa dalam penelitian ini terdiri 

dari 3 jenis beban yaitu beban mati, beban hidup, dan beban gempa. 

3.4.1 Beban Mati 

Beban mati yang diperhitungkan akan bekerja pada struktur gedung ini yaitu 

berat sendiri dari komponen-komponen struktur seperti kolom, balok, pelat, dan 

dinding geser yang ada pada bangunan tersebut beserta beban tambahan yang 

bekerja namun bukan merupakan elemen struktural. Adapun beban mati yang akan 

digunakan untuk proses analisis bangunan mengacu pada SNI 03-1727-1989 seperti 

yang ditunjukan pada Tabel 2.6 dan perencanaannya adalah sebagai berikut: 

Model 2 Model 3 

 

Model 4 Model 5 
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a. Berat sendiri dari komponen struktur akan dihitung secara langsung oleh 

software ETABS. 

b. Beban mati tambahan 

1. Lantai bassement 1 – lower ground 

- Adukan semen (tebal 3 cm) = 0,63 kN/m2                                                 

- Mekanikal & elektrikal  = 0,25 kN/m2 + 

= 0,88 kN/m2 

2. Ground floor 

- Adukan semen (tebal 3 cm) = 0,63 kN/m2 

- Penutup lantai   = 0,24   kN/m2 

- Plafond+penggantung  = 0,18 kN/m2 

- Mekanikal & elektrikal  = 0,25 kN/m2 + 

= 1,30 kN/m2 

3. Lantai 1 – Lantai 25 

- Adukan semen (tebal 3 cm) = 0,63 kN/m2 

- Penutup lantai   = 0,24   kN/m2 

- Plafond+penggantung  = 0,18 kN/m2 

- Mekanikal & elektrikal  = 0,25 kN/m2 + 

= 1,30 kN/m2 

4. Lantai atap 

- Adukan semen (tebal 3 cm) = 0,63 kN/m2 

- Waterproofing (tebal 2 cm) = 0,28 kN/m2 

- Plafond+penggantung  = 0,18 kN/m2 
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- Mekanikal & elektrikal  = 0,25 kN/m2 + 

= 1,34 kN/m2 

 

3.4.2 Beban Hidup  

      Beban hidup merupakan beban yang timbul akibat penggunaan dan 

penghuni gedung atau struktur lainnya yang sifatnya tidak tetap dalam struktur. 

Besarnya beban hidup mengacu pada ketentuan SNI 03-1727-2013 seperti yang 

ditunjukan pada Tabel 2.8 yang penggunaannya berdasarkan kriteria penggunaan 

lantai pada bangunan Apartemen Bassura City Tower Jasmine. Namun karena ada 

beberapa nilai yang kurang sesuai atau tidak terdapat diperaturan terbaru sehingga 

dalam perencanaan beban hidup juga mengacu pada SNI 03-1727-1989 pada Tabel 

2.7. Adapun perencanaan beban hidup yang akan digunakan dalam proses analisa 

penelitian ini sesuai dengan fungsi lantai adalah sebagai berikut:  

1. Lantai bassement 1 – lower ground 

Beban hidup parkiran        = 4,0 kN/m2  (Tabel 2.7) 

2. Ground floor 

Ruang publik (hunian rumah tinggal lainnya)   = 4,79 kN/m2 (Tabel 2.8) 

3. Lantai 1 – Lantai 25 

Ruang pribadi (hunian rumah tinggal lainnya)  = 1,92 kN/m2 (Tabel 2.8) 

4. Lantai atap 

Lantai atap        = 0,96 kN/m2 (Tabel 2.8) 

5. Pelat lantai tangga 

Beban hidup tangga       = 3,0 kN/m2  (Tabel 2.7) 
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3.4.3 Beban Gempa 

Beban gempa direncanakan dengan prosedur respon spektrum berdasarkan 

SNI 03-1726-2012. Tahapan perencanaan beban gempa menggunkan metode 

respon spektrum sebagai berikut: 

1. Parameter percepatan terpetakan 𝑆𝑆 dan 𝑆1 

Bangunan berlokasi di Jakarta Timur di mana berdasarkan peta gerak tanah 

pada Gambar 2.1 dan Gambar 2.2 nilai 𝑆𝑆 dan 𝑆1 utuk kota Jakarta berada 

pada rentan nilai 0,6-0,7 g dan 0,2-0,3 g. Untuk lebih tepatnya dengan 

bantuan aplikasi desain spektra Indonesia dari Pusat Penelitian dan 

Pengembangan Pemukiman, Kementrian Pekerjaan Umum untuk Jakarta 

Timur didapatkan nilai: 

a. Percepatan batuan dasar pada perioda pendek 𝑆𝑆 = 0.679 g  

b. Percepatan batuan dasar pada perioda 1 detik  𝑆1= 0.297 g. 

 

2. Koefisien situs 𝐹𝑎 dan 𝐹𝑣 

Berdasarkan Tabel 2.10 dan Tabel 2.11 untuk kelas situs SD (tanah sedang) 

dan dengan nilai 𝑆𝑆 = 0.679 g dan 𝑆1 = 0.297 g dengan interpolasi 

didapatkan nilai: 

a. Faktor amplikasi getaran terkait percepatan pada getaran perioda 

pendek 𝐹𝑎 = 1.257 

b. Faktor amplikasi getaran terkait percepatan pada getaran perioda 1 

detik 𝐹𝑣 = 1.806 

 

3. Parameter spektrum respon percepatan 𝑆𝑀𝑆 dan 𝑆𝑀1 
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𝑆𝑀𝑆 =  𝐹𝑎  ×  𝑆𝑆 = 1.257 ×  0.679 = 0.853   

𝑆𝑀1 =  𝐹𝑣  ×  𝑆1 = 1.806 ×  0.297 = 0.536  

 

4. Parameter percepatan spektral desain 𝑆𝐷𝑆 dan 𝑆𝐷1 

𝑆𝐷𝑆 =
2

3
𝑆𝑀𝑆 =

2

3
 ×  0.766 = 0.569  

𝑆𝐷1 =
2

3
𝑆𝑀1 =

2

3
 ×  0.446 = 0.358  

 

5. Kurva respon spektrum desain 

𝑇0 = 0.2
𝑆𝐷1

𝑆𝐷𝑆
= 0.2

0.358

0.569
= 0.126  

𝑇𝑠 = 0.2
𝑆𝐷1

𝑆𝐷𝑆
=

0.358

0.569
= 0.629  

Menghitung percepatan respon spectral (𝑆𝑎) 

a. Untuk 𝑇 ≤  𝑇0  : 𝑆𝑎 = 𝑆𝐷𝑆  (0.4 + 0.6
𝑇

𝑇0
) 

                   𝑆𝑎 = 0.511 (0.4 + 0.6
𝑇

0.117
) 

b. Untuk 𝑇0 ≤ 𝑇 ≤ 𝑇𝑠 :  𝑆𝑎 =  𝑆𝐷𝑆 = 0.511 

c. Untuk 𝑇 ≥ 𝑇𝑠  : 𝑆𝑎 =
𝑆𝐷𝑆

𝑇
=

0.511

𝑇
  

Maka kurva respon spektrum berdasarkan data-data diatas dapat ditunjukan 

pada gambar di bawah ini: 
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Gambar 3.7 Kurva Respon Spektrum 

 

3.4.4 Kombinasi Pembebanan 

Nilai parameter percepatan spectral desain pada perioda pendek (𝑆𝐷𝑆) adalah 

0,511. Berdasarkan Tabel 2.11, karena nilai 𝑆𝐷𝑆 > 0,50 dan dengan kategori resiko 

II maka gedung ini termasuk kategori desain seismic D dan memiliki faktor 

redunansi (𝜌) sebesar 1,3. Dengan mensubsitusikan nilai 𝑆𝐷𝑆 dan nilai redunansi 

(𝜌) ke dalam persamaan pada kombinasi pembebanan, maka akan diperoleh 

kombinasi pemebebanan seperti berikut: 

1. 1,4D 

2. 1,2D + 1,6L 

3. 1,35D + 1,0L + 0,39𝑄𝐸𝑥+ 1,3𝑄𝐸𝑦 

4. 1,05D + 1,0L - 0,39𝑄𝐸𝑥 - 1,3𝑄𝐸𝑦 

5. 1,12D + 1,0L +  0,39𝑄𝐸𝑥 - 1,3𝑄𝐸𝑦 

6. 1,28D + 1,0L - 0,39𝑄𝐸𝑥+ 1,3𝑄𝐸𝑦 
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7. 1,35D + 1,0L + 1,3𝑄𝐸𝑥  + 0,39𝑄𝐸𝑦 

8. 1,05D + 1,0L − 1,3𝑄𝐸𝑥 − 0,39𝑄𝐸𝑦 

9. 1,28D + 1,0L + 1,3𝑄𝐸𝑥 − 0,39𝑄𝐸𝑦 

10. 1,12D + 1,0L − 1,3𝑄𝐸𝑥 + 0,39𝑄𝐸𝑦 

11. 0,75D + 0,39𝑄𝐸𝑥 + 1,3𝑄𝐸𝑦 

12. 1,05D − 0,39𝑄𝐸𝑥 − 1,3𝑄𝐸𝑦 

13. 0,98D + 0,39𝑄𝐸𝑥 − 1,3𝑄𝐸𝑦  

14. 0,82D − 0,39𝑄𝐸𝑥 + 1,3𝑄𝐸𝑦 

15. 0,75D + 1,3𝑄𝐸𝑥  +  0,39𝑄𝐸𝑦 

16. 1,05D − 1,3𝑄𝐸𝑥  − 0,39𝑄𝐸𝑦 

17. 0,82D + 1,3𝑄𝐸𝑥  − 0,39𝑄𝐸𝑦 

18. 0,98D − 1,3𝑄𝐸𝑥 + 0,39𝑄𝐸𝑦 

 

Namun sesuai dengan focus penelitian ini untuk mengetahui respon struktur 

bangunan terhadap gempa dan  dengan pertimbangan bahwa suatu struktur 

bangunan perlu diperhitungkan terhadap adanya kombinasi pembebanan dari 

beberapa kasus beban baik pembebanan tetap (beban hidup dan beban mati) 

maupun pembebanan sementara (beban gempa) yang dapat bekerja secara 

bersamaan selama umur rencana. Maka dari 18 kombinasi diatas akan digunakan 8 

kombinasi pembebanan yang meninjau semuan unsur pembebanan yaitu beban 

hidup, beban mati, dan beban gempa. Kombinasi-kombinasi yang digunakan dalam 

proses analisis penelitian ini adalah sebagai berikut: 
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1. 1,35D + 1,0L + 0,39𝑄𝐸𝑥+ 1,3𝑄𝐸𝑦 

2. 1,05D + 1,0L – 0,39𝑄𝐸𝑥 – 1,3𝑄𝐸𝑦 

3. 1,12D + 1,0L +  0,39𝑄𝐸𝑥 – 1,3𝑄𝐸𝑦 

4. 1,28D + 1,0L – 0,39𝑄𝐸𝑥 + 1,3𝑄𝐸𝑦 

5. 1,35D + 1,0L + 1,3𝑄𝐸𝑥  + 0,39𝑄𝐸𝑦 

6. 1,05D + 1,0L − 1,3𝑄𝐸𝑥 − 0,39𝑄𝐸𝑦 

7. 1,28D + 1,0L + 1,3𝑄𝐸𝑥 − 0,39𝑄𝐸𝑦 

8. 1,12D + 1,0L − 1,3𝑄𝐸𝑥 + 0,39𝑄𝐸𝑦 

 

3.5 Teknik Analisis Data 

Teknik analisis data yang digunakan dalam penelitian ini adalah statistik 

deskriptif. Dengan statistik deskriptif proses menganalisis data akan dilakukan 

dengan cara mendeskripsikan atau menggambarkan data yang telah terkumpul 

sebagaimana adanya tanpa bermaksud membuat kesimpulan biasanya kedalam 

sebuah bentuk tabel dan grafik.  
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3.6 Diagram Alir Penelitian 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

 

 

Gambar 3.8 Diagram Alir Penelitan 
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1. Displacement 
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3. Base Shear 

Simpulan 
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Gambar 3.9 Diagram Alir Pemodelan Struktur dengan Software ETABS

Mulai 

Membuat grid 

Define material 

Define frame section untuk struktur 

kolom, balok, plat, dan dinding  

Input pembebanan  

Kombinasi 
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Penggambaran struktur kolom, 

balok, plat, dan dinding  

Assign perletakan 

Running program 

Selesai 
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BAB IV 

HASIL PENELITIAN DAN PEMBAHASAN 

4.1. Hasil Penelitian 

Setelah dilakukan proses analisa menggunakan program ETABS maka 

didapatkan beberapa hasil output yang menunjukan respon bangunan dari semua 

model dengan beragam variasi bukaan pada shear wall-nya. Sesuai dengan 

penjelasan pada bab-bab sebelumnya penelitian ini meninjau 3 parameter respon 

dari semua pemodelan yaitu base shear, displacement, dan story drift. Berikut ini 

adalah hasil output yang didapatkan dari proses analisa menggunakan program 

ETABS tersebut. 

4.1.1. Base Shear 

Berdasarkan hasil analisa ETABS dari keenam model bangunan dengan 

berbagai variasi bukaan pada shear wall-nya maka didapatkan perbandingan nilai 

base shear dari masing-masing model adalah sebagai berikut: 

Tabel 4.1 Nilai Base Shear Sebelum Terkoreksi 

MODEL 

Arah 
Berat Struktur 

(kN) 

Periode 

(s) 
𝑋  

(𝑘𝑁) 

𝑌  
(𝑘𝑁) 

Tanpa Bukaan 610,42 533,40 181440,33 0,672951 

Model 1 577,61 502,59 180771,34 0,718219 

Model 2 578,99 503,48 180771,34 0,715238 

Model 3 582,83 504,05 180771,34 0,713704 

Model 4 577,60 502,94 180087,23 0,718334 

Model 5 577,66 502,65 180087,23 0,718839 

      

Mengingat nilai base shear diatas merupakan hasil dari proses analisa 

menggunakan analisis respon dinamis maka perlu adanya evaluasi dari hasil 

tersebut. Karena sesuai dengan peraturan  SNI 03-1726-2012  nilainya  tidak  boleh
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kurang dari 85% gaya geser dasar (base shear) yang dihitung dengan menggunakan 

cara statik ekuivalen. Jika nilainya kurang dari standar maka ordinat respon 

spektrum/ faktor skala perlu dikoreksi. Berdasarkan perhitungan nilai base shear 

dari semua model masih dibawah standar yang ditentukan. Maka dari itu faktor 

skala perlu dikoreksi kembali agar mendapatkan nilai base shear yang sesuai. 

Adapun proses secara rinci evaluasi hasil dari nilai base shear yang telah didapat 

dari semua pemodelan dapat dilihat pada Lampiran 1 dan untuk faktor skala yang 

telah terkoreksi dari setiap model dapat dilihat pada Tabel 4.2. 

Tabel 4.2 Nilai Faktor Skala Terkoreksi 

MODEL Kasus Arah 
Faktor 

Skala Awal 

Faktor 

Skala Terkoreksi 

Tanpa 

Bukaan 

RSPX 
U1 1,225 20,590 

U2 0,368 6,176 

RSPY 
U1 0,368 7,067 

U2 1,225 23,558 

1 

RSPX 
U1 1,225 20,310 

U2 0,368 6,090 

RSPY 
U1 0,368 7,002 

U2 1,225 23,340 

2 

RSPX 
U1 1,225 20,350 

U2 0,368 6,110 

RSPY 
U1 0,368 7,020 

U2 1,225 23,400 

3 

RSPX 
U1 1,225 20,250 

U2 0,368 6,080 

RSPY 
U1 0,368 7,025 

U2 1,225 23,420 

4 

RSPX 
U1 1,225 20,220 

U2 0,368 6,070 

RSPY 
U1 0,368 6,097 

U2 1,225 23,230 

5 

RSPX 
U1 1,225 20,210 

U2 0,368 6,060 

RSPY 
U1 0,368 6,970 

U2 1,225 23,220 
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 Setelah didapatkan nilai faktor skala terkoreksi dari masing-masing model, 

maka dilakukan proses run analysis kembali menggunakan software ETABS 

dengan mengubah nilai faktor skala pada define respon spectrum case untuk RSPX 

dan RSPY sesuai dengan nilai yang telah didapat pada Tabel 4.2. Maka dari proses 

analisa kembali tersebut didapatkan nilai base shear seperti yang ditunjukan pada 

Tabel 4.3. Dari tabel tersebut menunjukan nilai base shear kini telah memenuhi 

standar yang telah ditentukan dari semua model. 

Tabel 4.3 Nilai Base Shear Terkoreksi 

MODEL 

Arah 

𝑋  
(𝑘𝑁) 

𝑌  
(𝑘𝑁) 

Tanpa Bukaan 10257,67 10257,80 

Model 1 9571,89 9575,85 

Model 2 9615,23 9617,45 

Model 3 9635,89 9636,57 

Model 4 9536,08 9537,29 

Model 5 9530,62 9535,92 

 

4.1.2. Displacement 

Berikut ini nilai displacement semua model bangunan dengan berbagai 

bentuk variasi bukaan pada penampang shear wall dari kedua arah yaitu arah X dan 

arah Y. Di mana nilai displacement diambil dari salah satu titik dan kombinasi 

pembebanan dari masing-masing model. Adapun nilai dari masing-masing model 

untuk arah X dapat dilihat pada Tabel 4.4 dan untuk arah Y pada Tabel 4.5. 
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Tabel 4.4 Nilai Displacement Arah X 

Lantai 

Tanpa 

Bukaan 

(mm) 

Model 1 

(mm) 
Model 2 

(mm) 
Model 3 

(mm) 
Model 4 

(mm) 
Model 5 

(mm) 

ATAP 198,202 216,016 214,370 212,414 214,770 214,773 

25 192,273 209,910 208,305 206,342 208,688 208,716 

23 185,846 203,296 201,732 199,765 202,095 202,154 

22 179,042 196,270 194,751 192,781 195,093 195,181 

21 171,879 188,837 187,365 185,397 187,687 187,800 

20 164,297 180,902 179,481 177,523 179,782 179,916 

19 156,629 172,712 171,348 169,406 171,625 171,773 

18 148,743 164,148 162,846 160,929 163,097 163,254 

17 140,569 155,184 153,950 152,066 154,175 154,333 

16 132,111 145,861 144,699 142,856 144,897 145,049 

15 123,371 136,188 135,106 133,310 135,276 135,413 

12 114,370 126,185 125,186 123,447 125,328 125,444 

11 105,194 115,968 115,054 113,378 115,169 115,259 

10 95,897 105,586 104,763 103,159 105,090 105,092 

9 86,442 95,429 94,291 92,765 95,043 95,007 

8 76,889 85,203 83,713 82,273 84,907 84,832 

7 67,420 74,698 73,206 71,859 74,489 74,376 

6 57,984 64,695 62,769 61,516 64,562 64,420 

5 48,859 54,561 52,659 51,504 54,495 54,329 

3 39,962 44,778 42,828 41,773 44,760 44,588 

2 31,397 35,657 33,391 32,473 35,662 35,509 

1 22,063 25,607 23,104 22,151 25,605 25,498 

GF 13,162 16,890 13,882 13,001 16,892 16,824 

LG 4,567 8,456 5,035 4,484 8,458 8,424 

B1 1,044 2,903 1,237 1,039 2,905 2,895 

BASE 0,000 0,000 0,000 0,000 0,000 0,000 
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Tabel 4.5 Nilai Displacement Arah Y 

Lantai 

Tanpa 

Bukaan 

(mm) 

Model 1 

(mm) 
Model 2 

(mm) 
Model 3 

(mm) 
Model 4 

(mm) 
Model 5 

(mm) 

ATAP 97,150 152,634 149,010 138,107 151,668 150,313 

25 95,472 150,205 146,630 135,902 149,262 147,933 

23 93,226 147,005 143,489 132,979 146,096 144,802 

22 90,735 143,193 139,741 129,492 142,320 141,068 

21 87,865 138,792 135,411 125,465 137,959 136,755 

20 84,688 133,785 130,482 120,882 132,994 131,841 

19 81,376 128,399 125,181 115,959 127,652 126,554 

18 77,953 122,607 119,482 110,671 121,906 120,865 

17 74,333 116,411 113,387 105,020 115,758 114,777 

16 70,503 109,844 106,929 99,039 109,242 108,321 

15 66,484 102,936 100,138 92,752 102,387 101,527 

12 62,293 95,711 93,038 86,181 95,216 94,417 

11 57,912 88,315 85,776 79,465 87,877 87,138 

10 53,340 80,684 78,285 72,539 80,302 79,624 

9 48,579 72,869 70,619 65,453 72,546 71,927 

8 43,666 64,905 62,810 58,234 64,640 64,081 

7 38,648 56,845 54,910 50,929 56,636 56,136 

6 33,518 48,896 47,124 43,732 48,742 48,300 

5 28,327 40,939 39,335 36,532 40,836 40,455 

3 23,095 33,058 31,629 29,411 33,003 32,684 

2 17,987 25,422 24,134 22,473 25,400 25,150 

1 12,349 17,114 15,620 14,506 17,087 16,940 

GF 6,430 9,715 7,552 6,985 9,710 9,643 

LG 0,778 3,344 0,635 0,732 3,345 3,334 

B1 0,137 2,284 0,019 0,120 2,284 2,271 

BASE 0,000 0,000 0,000 0,000 0,000 0,000 
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4.1.3. Story drift 

Story drift merupakan nilai simpangan suatu lantai yang diukur dari 

simpangan lantai dibawahnya. Dari nilai displacement yang didapat disetiap lantai 

dari berbagai model seperti yang ditunjukan pada sub bab sebelumnya maka 

didapatkan nilai story drift seperti yang ditunjukan pada Tabel 4.6 untuk arah X dan 

Tabel 4.7 untuk arah Y. 

Tabel 4.6  Nilai Story drift Arah X 

Lantai 

Tanpa 

Bukaan 

(mm) 

Model 1 

(mm) 
Model 2 

(mm) 
Model 3 

(mm) 
Model 4 

(mm) 
Model 5 

(mm) 

ATAP 5,929 6,106 6,065 6,072 6,082 6,057 

25 6,427 6,615 6,573 6,577 6,593 6,562 

23 6,804 7,026 6,982 6,984 7,002 6,973 

22 7,162 7,433 7,386 7,383 7,407 7,381 

21 7,583 7,935 7,884 7,875 7,905 7,884 

20 7,668 8,190 8,133 8,117 8,157 8,143 

19 7,886 8,565 8,502 8,477 8,527 8,519 

18 8,175 8,963 8,896 8,863 8,922 8,921 

17 8,458 9,324 9,251 9,210 9,278 9,285 

16 8,740 9,672 9,594 9,545 9,622 9,636 

15 9,001 10,004 9,920 9,863 9,948 9,969 

12 9,177 10,217 10,132 10,069 10,159 10,186 

11 9,296 10,382 10,291 10,219 10,079 10,167 

10 9,456 10,156 10,473 10,394 10,047 10,085 

9 9,553 10,227 10,578 10,492 10,136 10,175 

8 9,469 10,506 10,506 10,415 10,418 10,456 

7 9,436 10,003 10,438 10,343 9,927 9,956 

6 9,126 10,134 10,110 10,012 10,068 10,090 

5 8,897 9,783 9,831 9,731 9,735 9,741 

3 8,565 9,121 9,437 9,300 9,097 9,079 

2 9,334 10,050 10,287 10,322 10,057 10,011 

1 8,901 8,717 9,222 9,150 8,713 8,674 

GF 8,595 8,435 8,847 8,518 8,434 8,400 

LG 3,523 5,552 3,799 3,445 5,553 5,529 

B1 1,044 2,903 1,237 1,039 2,905 2,895 

BASE 0,000 0,000 0,000 0,000 0,000 0,000 
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Tabel 4.7 Nilai Story drift Arah Y 

Lantai 

Tanpa 

Bukaan 

(mm) 

Model 1 

(mm) 
Model 2 

(mm) 
Model 3 

(mm) 
Model 4 

(mm) 
Model 5 

(mm) 

ATAP 1,678 2,430 2,380 2,205 2,406 2,380 

25 2,246 3,199 3,141 2,923 3,166 3,131 

23 2,492 3,812 3,748 3,487 3,776 3,734 

22 2,869 4,401 4,330 4,027 4,361 4,314 

21 3,177 5,007 4,929 4,583 4,966 4,914 

20 3,312 5,386 5,301 4,923 5,342 5,287 

19 3,423 5,792 5,699 5,288 5,746 5,689 

18 3,620 6,196 6,095 5,651 6,147 6,088 

17 3,830 6,567 6,458 5,982 6,516 6,456 

16 4,020 6,908 6,791 6,287 6,855 6,794 

15 4,191 7,225 7,100 6,571 7,171 7,110 

12 4,381 7,396 7,262 6,717 7,339 7,279 

11 4,572 7,632 7,491 6,926 7,575 7,515 

10 4,761 7,814 7,666 7,086 7,756 7,696 

9 4,913 7,964 7,809 7,219 7,906 7,847 

8 5,018 8,060 7,900 7,305 8,004 7,945 

7 5,130 7,949 7,785 7,197 7,894 7,836 

6 5,191 7,956 7,790 7,200 7,905 7,845 

5 5,232 7,881 7,705 7,121 7,834 7,771 

3 5,108 7,637 7,495 6,938 7,603 7,534 

2 5,638 8,307 8,514 7,968 8,313 8,211 

1 5,919 7,399 8,068 7,521 7,377 7,297 

GF 5,652 6,371 6,917 6,253 6,365 6,309 

LG 0,641 1,060 0,616 0,612 1,061 1,063 

B1 0,137 2,284 0,019 0,120 2,284 2,271 

BASE 0,000 0,000 0,000 0,000 0,000 0,000 
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4.2. Pembahasan 

4.2.1.  Analisa Nilai Base Shear 

Base shear merupakan perkiraan kekuatan lateral maksimum yang akan 

diterima bangunan karena gerakan tanah akibat gempa di dasar struktur yang besar 

nilainya biasanya bergantung pada beberapa faktor. Faktor-faktor tersebut adalah 

kondisi tanah, potensi aktivitas seismik, tingkat daktilitas yang terkait dengan 

berbagai konfigursi struktural dan berat total struktur serta periode getar alami dari 

struktur saat mengalami pembebanan dinamis.  

Dari hasil analisa jika dibandingkan nilai base shear dari masing-masing 

model seperti yang ditunjukan pada Grafik 4.1. Terlihat bahwa terdapat perbedaan 

dari nilai base shear masing-masing model baik dari arah X maupun arah Y. 

 

 

 

 

 

 

 

 

Gambar 4.1 Perbandingan Nilai Base Shear 
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Berdasarkan grafik tersebut menunjukan bangunan dengan shear wall tanpa 

bukaan memiliki nilai base nnshear yang lebih tinggi jika dibandingkan  terhadap 

bangunan yang menggunakan shear wall dengan bukaan. Perlu diingat bahwa 

besarnya nilai base shear dipengaruhi beberapa faktor salah satunya adalah 

daktilitas struktur yang terkait dengan diantaranya konfigurasi struktur. Di mana 

secara denah bangunan Apartemen Bassura City Tower Jasmine ini arah Y lebih 

lebar dibanding arah X sehingga nilai base shear pada arah Y disemua model 

memiliki nilai yang paling besar dibanding arah X. Selain itu, faktor lainnya adalah 

berat struktur. Jika ditinjau dari segi faktor tersebut memang adanya bukaan 

tentunya menyebabkan perubahan berat struktur itu sendiri hal ini bisa dilihat 

perbandingannya dalam Tabel 4.8. 

Tabel 4. 8 Berat Struktur Masing-masing Model 

MODEL 
Berat Struktur 

(kN) 

Tanpa Bukaan 181440,328 

Model 1 180771,34 

Model 2 180771,34 

Model 3 180771,34 

Model 4 180087,231 

Model 5 180087,231 

  

Berdasarkan tabel diatas terlihat memang berat stuktur bangunan yang 

terbesar berada pada bangunan dengan shear wall tanpa bukaan. Sedangkan pada 

model 1, 2 dan 3 yang sama-sama memiliki 1 buah bukaan disetiap penampangnya 

nilai berat strukturnya menurun sebesar 0,37% dan untuk model 4 dan 5 yang 

memiliki 2 buah bukaan pada setiap penampangnya menurun sebesar 0,74% jika 

dibandingkan dengan bangunan dengan shear wall tanpa bukaan. Hal ini sejalan 

dengan nilai base shear yang didapatkan dari masing-masing model di mana 
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dengan adanya pengurangan berat struktur menyebabkan penurunan nilai base 

shear. Dapat dilihat bahwa perbandingan antara nilai base shear antara bangunan 

dengan shear wall tanpa bukaan terhadap model 1,2, dan 3 terjadi penurunan nilai 

base shear secara berturut-turut sebesar 6,64%, 6,26%, 6,1% sedangkan untuk 

model 4 dan 5 sedikit lebih meningkat penurunannya yaitu sebesar 7,01% dan 

7,08%.  

Namun, seperti yang telah disebutkan sebelumnya selain faktor berat struktur 

yang dapat mempengaruhi nilai base shear adalah periode struktur bangunan 

tersebut. Periode struktur merupakan waktu yang diperlukan untuk bangunan 

kondisi semula setelah menerima beban gempa. Besarnya periode selain 

bergantung dengan massa juga dipengaruhi dengan kekakuan struktur bangunan 

tersebut. Hal ini dapat terlihat perbandingan antara bangunan dengan shear wall 

model 1, model 2, dan model 3 dengan berat struktur yang sama, nilai base shear 

dari masing-masing model berbeda karena dari segi nilai periode masing-masing 

model juga berbeda. Kasus tersebut juga bisa dilihat pada bangunan dengan model 

4 dan model 5. Nilai periode dari masing-masing model bisa dilihat pada Grafik 4.2 

 

 

 

 

 

Gambar 4.2 Nilai Periode Struktur Masing-Masing Model 
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Terlihat bahwa diantara model 1,2, dan 3 di mana model 1 dengan bukaan  

yang diposisikan di tepi penampang shear wall menunjukan periode terbesar dan 

pada model 2 dan 3 periode semakin menurun seiring dengan perpindahan posisi 

bukaan diletakan di pusat penampang shear wall di mana penurunan yang terjadi 

untuk model 2 (0,42%) dan model 3 (0,63%). Kemudian untuk model 4 dan model 

5 dengan jumlah bukaan yang lebih banyak dengan konfigurasi posisi yang berbeda 

menunjukan hasil periode yang berbeda pula di mana model 4 dengan dua buah 

bukaan yang diposisikan pada pusat penampang shear wall menunjukan periode 

yang lebih kecil dibandingankan dengan model 5 yang posisi bukaannya 

disesuaikan dengan layout ruangan periode menunjukan peningkatan 0,07% 

dibandingan dengan periode pada model 4.  

Jika dihubungkan nilai periode dengan nilai base shear dari antara model 1,2, 

dan 3 dilihat dengan massa struktur yang sama menunjukan bahwa semakin kecil 

nilai periode maka nilai base shear akan semakin besar dan sebaliknya, begitu pula 

pada model 4 dan 5. Mengingat besarnya periode selain depengaruhi dengan massa 

juga dipengaruhi oleh kekakuan struktur di mana nilai periode yang semakin kecil 

menunjukan bahwa bangunan memiliki kekakuan yang cukup baik karena hanya 

membutuhkan waktu sedikit untuk kembali ke kondisi semula setelah menerima 

beban gempa begitupun sebaliknya. Hal tersebut menunjukan bukaan dengan 

ukuran kecil dan posisi di pusat penampang shear wall sifat yang lebih fleksibel 

dibanding variasi bukaan lainnya. 
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4.2.2. Analisa Nilai Displacement 

Displacement (Simpangan lantai) merupakan nilai simpangan dari suatu 

lantai yang ditinjau dari lantai dasar bangunan tersebut. Nilai displacement 

merupakan salah satu parameter yang dapat digunakan untuk meninjau tingkat 

kekakuan struktur. Di mana nilai simpangan yang kecil menunjukan bangunan 

tersebut memiliki kekakuan struktur yang besar. Namun sebaliknya semakin besar 

nilai simpangan menunjukan kekakuan struktur tersebut semakin kecil. 

Berdasarkan hasil analisa keenam model bangunan dengan shear wall tanpa 

bukaan dan shear wall yang memiliki bukaan dengan posisi dan ukuran yang 

bervariasi  menghasilkan nilai displacement yang berbeda-beda dikedua arahnya.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar 4.3 Nilai Displacement Arah X 
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Tabel 4. 9 Perbandingan Nilai Displacement Arah X 

 

Setelah diamati dari grafik dan tabel diatas perbandingan nilai displacement 

untuk arah X dari semua model menunjukan adanya bukaan pada shear wall dapat 

meningkatkan nilai displacement dibandingkan dengan model tanpa bukaan. Dapat 

terlihat jika dibandingkan nilai displacement bangunan menggunakan shear wall 

tanpa bukaan dengan shear wall yang diberikan variasi bukaan mulai dari model 1, 

model 2, model 3, model 4, dan model 5 mengalami peningkatan secara berturut-

turut sebesar 8,9%, 8,2%, 7,2%, 8,36%, dan 8,362%. 

 

 

 

 

 

 

 

 

 

Grafik 4.4 Gambar Nilai Displacement Arah Y 
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Tabel 4. 10 Perbandingan Nilai Displacement Arah Y 

 

Peningkatan nilai displacement akibat adanya bukaan pada penampang shear 

wall juga terlihat untuk nilai displacement arah Y seperti yang ditunjukan pada 

grafik dan tabel diatas. dan untuk arah Y Model 1 (57,1%), Model 2 (53,4%), Model 

(42,2%), Model 4 (56,2%) dan Model (55%).  

Pada intinya adanya bukaan pada shear wall menyebabkan perubahan nilai 

displacement dan cenderung menyebabkan peningkatan menjadi semakin besar. 

Hal ini menunjukan bahwa adanya bukaan menyebabkan kekauan struktur 

berkurang. 

Jika dilihat, besarnya peningkatan nilai displacement dari berbagai model 

bukaan nilainya beragam. Hal ini disebabkan adanya perubahan konfigurasi posisi 

dan jumlah bukaan di beberapa model dibandingkan dengan bukaan eksisting yaitu 

pada model 2. Untuk mengetahui perbandingan nilai displacement berbagai variasi 

model bukaan terhadap bukaan eksisting dapat dilihat pada Grafik 4.6 
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97,15 152,6 +57,1% 149,01 +53,4% 138,1 +42,2% 151,7 +56,2% 150,3 +55% 
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Gambar 4.5 Perbandingan Displacement Eksisting dan Variasi Bukaan 

 

Untuk model 1 posisi bukaan diletakan lebih dekat dengan tepi penampang 

shear wall dibandingkan dengan bukaan eksisting. Dengan ukuran bukaan yang 

sama, namun posisi yang berbeda tersebut jika dibandingkan nilai displacement 

baik arah X mapun arah Y dari proses analisa menunjukan hasil yang berbeda. 

Berdasarkan grafik diatas terlihat bahwa nilai displacement untuk model 1 

mengalami peningkatan dibandingkan nilai displacement pada model eksisting. Di 

mana penurunan terjadi dikedua arah baik arah X maupun arah Y. Untuk arah X 

terjadi peningkatan sebesar 0,76% sedangkan untuk arah Y peningkatan terjadi 

sebesar 2,41%. Dari hasil tersebut menunjukan bahwa dengan ukuran bukaan yang 

sama namun posisi yang berbeda di mana yang lebih mendekati tepi penampang 

shear wall menghasilkan perbedaan nilai displacement dan cenderung mengalami 

peningkatan. Hal ini dikarenakan memposisikan bukaan secara asimetris akan 

menyebabkan aliran gaya yang diterima shear wall tidak dapat terprediksi. 
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Kemudian pada model 3 dengan ukuran bukaan yang sama pula dengan 

eksisting namun bukaan diposisikan pada pusat penampang shear wall. dari grafik 

diatas menunjukan bahwa model 3 menghasilkan nilai displacement yang lebih 

kecil dibandingkan dengan model eksisting. Terlihat bahwa adanya penurunan nilai 

displacement dari model eksisting terhadap model 3 dikedua arahnya yaitu sebesar 

0,93% untuk arah X dan 7,32% untuk arah Y. Berdasarkan perbandingan tersebut 

menunjukan bahwa sama seperti perbandingan sebelumnya dengan ukuran yang 

sama dan posisi yang berbeda namun kali ini bukaan diposisikan pada pusat 

penampang shear wall menunjukan hasil yang lebih baik dibandingkan dengan 

eksisting karena cenderung menurunkan nilai displacement. Ini menunjukan 

bukaan yang diposisikan pada pusat penampang shear wall menghasilkan kekakuan 

yang lebih baik dibanding posisi lainnya. Karena jika ditinjau dari teori inersia 

penampang bukaan atau lubang yang berada didekat pusat penampang akan 

menghasilkan nilai inersia yang lebih besar. 

Sedangkan jika dibandingkan bukaan pada model 4 yang jumlah bukaannya 

ditingkatkan menjadi 2 buah bukaan disetiap penampangnya dibandingkan dengan 

model bukaan eksisting dan kedua bukaan tersebut diposisikan sesuai dengan pusat 

penampang shear wall didapatkan perbandingan nilai displacement antara model 4 

dengan model eksisting yaitu model 2 menunjukan peningkatan. Berdasarkan 

grafik diatas untuk arah X peningkatan terjadi sebesar 0,173%, sedangkan untuk 

arah Y peningkatan terjadi sebesar 1,81%. Dari perbandingan tersebut menunjukan 

bahwa adanya penambahan jumlah bukaan menyebabkan peningkatan nilai 

displacement walaupun dengan posisi bukaan yang berada di pusat penampang 

shear wall.  
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Sama dengan model 4 pada model 5 jumlah bukaan juga ditingkatkan menjadi 

2 buah bukaan di setiap penampang shear wall dengan posisi yang berbeda, di mana 

pada model ini posisi diatur mengikuti layout ruangan sehingga posisinya sedikit 

tidak beraturan. Jika dibandingkan dengan model eksisting dari segi nilai 

displacement menunjukan adanya peningkatan. Di mana berdasarkan grafik diatas 

peningkatan terjadi sebesar 0,174% untuk arah X Sedangkan untuk arah Y terjadi 

0,87%. Sama dengan sebelumnya adanya penambahan jumlah bukaan apalagi 

dengan posisi yang tidak teratur juga menyebabkan peningkatan nilai displacement. 

Selain itu, terlihat dari semua hasil pemodelan baik model bangunan dengan 

shear wall tanpa bukaan maupun model bangunan dengan shear wall yang memiliki 

bukaan dengan berbagai ukuran dan posisi sama-sama menunjukan nilai 

displacement pada arah X selalu lebih besar dibandingkan dengan arah Y. Hal ini 

dikarenakan secara konfigurasi denah bangunan arah Y lebih lebar dibandingkan 

dengan arah X, yang menunjukan pada kasus bangunan ini sumbu lemah berada di 

sumbu X dan sumbu Y sebagai sumbu kuat. Faktor lainnya adalah dinding geser 

yang menahan gaya gempa untuk arah Y lebih luas dari pada arah X sehingga 

kekakuan struktur pada arah Y lebih besar dari arah  X. Namun, dari besarnya 

peningkatan dibandingkan dengan model tanpa bukaan menunjukan pada arah Y 

peningkatannya terlihat lebih signifikan dibanding arah Y. Hal ini dikarenakan 

jumlah bukaan yang diterapkan pada shear wall yang menahan beban gempa dari 

sumbu Y lebih besar dibandingkan dengan shear wall pada sumbu X. Artinya, 

semakin banyak bukaan yang diterapkan pada salah satu sumbu akan menyebabkan 

pengaruh yang cukup besar teradapa perubahan respon bangunan yang dalam hal 

ini ditinjau dari segi nilai displacement.   
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Namun secara nilai simpangan dari semua model di kedua arahnya masih 

dalam batas aman jika dihitung sebagai defleksi pusat masa dengan persamaan 2.1. 

Di mana nilai simpangan tidak melebihi batas simpangan ijin. Seperti yang 

ditunjukan pada Tabel 4.11. 

Tabel 4.11. Kontrol Nilai Displacement 

Model 
Simpangan 

Arah X 

Simpangan 

Arah Y 

Simpangan 

Ijin 

Keterangan 

Arah X Arah Y 

Tanpa Bukaan 1090.11 484.8652 1408.4 Aman Aman 

1 1188.087 755.5878 1408.4 Aman Aman 

2 1179.034 740.5662 1408.4 Aman Aman 

3 1168.276 685.6119 1408.4 Aman Aman 

4 1181.235 751.4579 1408.4 Aman Aman 

5 1181.251 744.4008 1408.4 Aman Aman 

 

4.2.3.  Analisa Nilai Story drift 

Story drift atau simpangan antar tingkat merupakan simpangan yang 

didapatkan dari nilai selisih simpangan yang ditinjau dengan nilai simpangan dari 

lantai dibawahnya. Sama dengan displacement nilai story drift juga dapat sebagai 

parameter ukur kekakuan struktur bangunan tersebut namun kali ini dilihat dari 

setiap lantai bangunan tersebut. semakin kecil nilai story drift yang didapat 

menunujukan semakin besar kekakuan lantai tersebut begitu pula sebaliknya. Selain 

itu, biasanya nilai-nilai yang didapatkan digunakan sebagai suatu indikator kinerja 

batas ultimit struktur terutama untuk bangunan tinggi. Hal ini dilakukan untuk 

mengetahui tingkat keamanan bangunan tersebut terhadap adanya kemungkinan 

keruntuhan struktur yang akan membawa korban jiwa. 
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Adapun gambaran nilai story drift yang didapat dari masing-masing lantai 

berbagai model bangunan dengan shear wall tanpa bukaan dan dengan shear wall 

dengan berbagai variasi bukaan di kedua arah disajikan dalam Gambar 4.6 dan 

Gambar 4.7 

 

 

 

 

 

 

 

 

 

 

Gambar 4.6 Story drift Arah X 

 

 

 

 

 

 

 

Gambar 4.7 Story drift Arah Y 
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Berdasarkan grafik diatas sejalan dengan nilai displacement bangunan dengan 

shear wall tanpa bukaan menghasilkan nilai story drift yang lebih kecil 

dibandingkan terhadap model dengan bukaan. Selain itu terlihat diantara semua 

lantai nilai story drift terbesar dikedua arah berada di lantai 2. Hal ini disebabkan 

oleh beberapafaktor diantaranya berbedaan tinggi lantai dari lantai sebelumnya 

memang lebih besar dibanding lantai lainnya. Karena besarnya nilai story drift atau 

simpangan antar tingkat nilainya salah satunya dipengaruhi oleh ketinggian antar 

lantai. Selain itu, karena adanya perbedaan ketinggian lantai tersebut bangunan ini 

memiliki ketidak beraturan kekakuan tingkat (soft story) pada tingkat tersebut. pada 

lantai ini pula terjadi pengecilan kolom dan bukaan mulai diterapkan yang 

menyebabkan kekakuan struktur semakin berkuran dibanding lantai sebelumnya. 

Sesuai dengan ketentuan pada SNI 1726-2012, nilai drift yang didapat tidak 

boleh melebihi drift limit yang ditinjau, di mana besarnya nilai story drift yang 

diijinkan tidak boleh melampaui 0,02 kali tinggi tingkat. Hal ini perlu untuk 

membatasi kemungkinan terjadinya keruntuhan struktur. Maka dari itu perlu 

dilakukan evaluasi terhadap nilai story drift yang didapat dari proses analisa setiap 

model untuk mengetahui hasil yang didapat masih dalam batas aman atau tidak. 

Berdasarkan hasil evaluasi nilai story drift untuk semua model pada arah X maupun 

arah Y masih pada batas aman dikedua arahnya. 

 

4.2.4. Analisa Kuat Geser Shear Wall 

Pada prinsipnya dinding geser bekerja sebagai sebuah balok kantilever 

vertikal yang menyediakan tahanan lateral dan menyebabkan dinding geser 
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menerima gaya tekuk maupun geser. Dengan demikian, dinding geser harus cukup 

kuat menahan gaya geser yang terjadi pada struktur. Berdasarkan SNI 03-2847-

2013 kuat geser nominal untuk dinding geser dapat ditentukan dengan persamaan 

2.4 dan 2.5 di mana nilai yang digunakan diambil dari nilai yang lebih kecil diantara 

kedua persamaan tersebut.  

Berdasarkan hasil perhitungan nilai kuat geser dari masing-masing model 

pada Lampiran 3 menunjukan hasil seperti yang ditunjukan pada Tabel 4.12. 

Tabel 4.12. Perbandingan Kuat Geser 

Model 
Kuat Geser 

(N) 

Tanpa Bukaan 695079 

1 𝟓𝟓𝟔𝟏𝟗𝟒 

2 𝟓𝟗𝟔𝟗𝟏𝟒 

3 𝟔𝟓𝟐𝟗𝟖𝟑 

4 𝟓𝟓𝟒𝟑𝟎𝟕 

5 𝟓𝟓𝟑𝟏𝟒𝟐 

 

Dari tabel diatas menunjukan kinerja yang lebih baik ditunjukan pada model 

tanpa bukaan, hal ini terlihat dari nilai kuat geser shear wall tanpa bukaan 

menunjukan hasil yang lebih besar dibandingkan model lainnya. Karena adanya 

bukaan dengan berbagai ukuran dan posisi menyebakan penurunan nilai kuat geser 

shear wall di mana terjadi penurunan pada model 1 (19,98%), model 2 (14,12%), 

model 3 (6,06%), model 4 (20.25%) dan model 5 (20,42%). 

Dari hasil analisa diatas juga menunjukan dengan adanya perbedaan posisi 

dan ukuran bukaan menghasilkan nilai kuat geser yang beragam. Di mana bukaan 

pada model 3 menunjukan nilai kuat geser yang lebih besar dengan model bukaan 

lainnya termasuk model eksisting yaitu model 2. Artinya, model 3 memiliki kinerja 
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yang lebih baik karena lebih mampu menahan gaya geser yang lebih besar yang 

terjadi pada struktur ketika menerima gempa. 

4.3. Analisa Keseluruhan 

Berdasarkan hasil pembahasan menunjukan bahwa adanya bukaan pada 

penampang shear wall mempengaruhi respon bangunan terhadap gempa. Hal ini 

terlihat dari hasil analisa berbagai parameter respon yang ditinjau terjadi perbedaan 

di masing-masing model bukaan. 

 

 

 

 

 

 

 

Gambar 4.8 Hubungan Base Shear dengan Displacement 

 

Berdasarkan grafik diatas menunjukan bahwa nilai base shear berbanding 

terbalik dengan nilai displacement. Di mana semakin besar nilai base shear maka 

nilai displacement akan semakin menurun dan sebaliknya. Artinya nilai base shear 

yang besar menunjukan bahwa bangunan tersebut memiliki kinerja yang lebih baik 

dalam menahan beban gempa, sehingga dapat meminimalkan nilai displacement. 

Jika dilihat dari shear wall tanpa bukaan memiliki kinerja yang lebih baik dalam 
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menerima beban gempa. Hal ini terlihat dari nilai base shear untuk shear wall tanpa 

bukaan memiliki nilai yang lebih besar dibandingkan dengan shear wall yang 

memiliki bukaan. di mana hal ini dipengaruhi oleh salah satu faktornya adalah berat 

struktur. Di mana adanya bukaan membuat berat struktur berkurang dan berdampak 

pada berkurangnya nilai base shear. Nilai displacement juga menunjukan hasil yang 

lebih baik dimana model shear wall tanpa bukaan menghasilkan nilai displacement 

yang lebih kecil.  

Sedangkan jika dilihat perbandingan antara masing-masing model shear wall 

yang memiliki bukaan dengan berbagai variasi posisi dan ukuran menunjukan hasil 

yang berbeda pula. Dari segi nilai base shear terlihat bahwa penempatan satu 

bukaan dipusat penampang menunjukan kinerja yang lebih baik—karena  

menunjukan nilai yang lebih besar—dibandingkan  dengan bukaan yang 

diposisikan mendekati tepi penampang shear wall. Di samping itu penambahan 

luasan bukaan akan menurunkan nilai base shear.  

Jika ditinjau dari nilai periode struktur diperoleh hasil bahwa semakin kecil 

periode maka semakin besar nilai base shear yang didapat pada pemodelan yang 

dimaksud. Pada model 3 dengan bukaan di pusat penampang shear wall 

menunjukan nilai periode terkecil diantara variasi model yang lain. Dengan massa 

bangunan yang sama, nilai base shear dapat menunjukkan nilai yang berbeda karena 

perbedaan nilai perode strukur tersebut. kali ini dipengaruhi oleh besarnya nilai 

periode yang lebih kecil dibanding model lainnya. Artinya semakin kecil nilai 

periode menyebabkan nilai base shear semakin besar sehingga bukaan kecil dipusat 

penampang menghasilkan kinerja yang lebih baik. Hal ini diperkuat dengan nilai 

displacement dari model tersebut lebih kecil dibanding model lainnya.  
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Selain itu, dari segi nilai story drift nilainya berbanding lurus dengan nilai 

displacement. Di mana semakin besar nilai displacement maka nilai simpangan 

antar tingkat (story drift ) juga akan semakin besar. berdasarkan hasil evalusi kinerja 

batas ultimit dari nilai stor drift yang didapat semua model shear wall masih dalam 

batas aman. 

Penurunan kinerja shear wall ini juga ditunjukan dengan menurunnya 

kemampuan shear wall dalam menahan gaya geser. Terlihat dari nilai kuat geser 

yang dihitung dari setiap model terjadi penurunan pada semua model dengan 

bukaan dibandingkan dengan model tanpa bukaan. Namun pada model 3 terjadi 

penurunan yang lebih kecil dibandingkan dengan model lainnya dari segi nilai kuat 

geser. 

Dari hasil analisa keseluruhan menunjukan besarnya nilainya perubahan 

tergantung akan posisi dan ukuran bukaan tersebut. Walaupun dalam hal ini faktor 

posisi lebih terlihat pengarunhnya dibandingkan dengan faktor ukuran jika dilihat 

dari perbandingannya dengan eksisting. 

 

4.4. Keterbatasan Penelitian 

1. Dalam proses analisa tidak mempertimbangkan adanya soft story dan 

perbedaan ketinggian pada shear wall. 

2. Analisa ETABS masih belum sempurna karena dari hasil eksisting masih ada 

komponen-komponen struktur yang overstress.
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BAB V 

KESIMPULAN DAN SARAN 

5.1. Kesimpulan 

Setelah melakukan proses analisa data mengenai perbandingan respon 

bangunan dengan adanya variasi bukaan pada penampang shear wall maka dapat 

ditarik kesimpulan dari hasil penelitian ini adalah: 

1. Adanya bukaan pada shear wall menyebabkan penurunan nilai base shear 

sekitar 6%-7% dan peningkatan nilai displacement rata-rata 8,2% untuk arah 

X dan rata-rata 52,78% untuk arah Y yang menunjukan bahwa respon 

bangunan yang kurang baik terhadap gempa dibandingkan dengan shear wall 

tanpa bukaan. 

2. Pemindahan posisi bukaan menyebabkan respon bangunan yang berbeda-

beda terlihat jika dibandingkan dengan model 2 (eksisting)  dengan ukuran 

yang sama namun posisi berbeda pada model 1 mengalami peningkatan nilai 

displacement 0,76% (arah X) dan 2,41% (arah Y). Sedangkan pada model 3 

mengalami penurunan sebesar 0,93% (arah X) dan 7,32% (arah Y). ini 

menunjukan bukaan yang di posisikan mendekati tepi penampang shear wall 

menunjukan respon yang kurang baik dibandingkan bukaan yang diposisikan 

pada pusat penampang shear wall. 

3. Adanya penambahan ukuran bukaan juga memiliki pengaruh terhadap 

besarnya perubahan respon bangunan. Walaupun dalam hal ini terlihat tidak 

terlalu signifikan dibandingkan posisi karena nilainya terlalu kecil. Terlihat 

dibandingkan dengan eksisting pada model 4 dan 5 mengalami peningkatan 
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nilai displacement secara berturut-turut kedua arahnya sebesar 1,73 % dan 

1,74% untuk arah X sedangkan untuk arah Y 1,81% dan 0,87%. 

4. Dibandingkan dengan bukaan eksisting dan variasi bukaan lainnya, variasi 

pada Model 3 dengan 1 buah bukaan dan posisi dipusat penampang shear 

wall merupakan bukaan yang optimum dalam meminimalkan penurunan 

kinerja shear wall akibat bukaan. 

5.2. Saran 

Demi kesempurnaan penelitian kedepannya mengenai pengaruh bukaan pada 

shear wall terhadap respon bangunan tinggi khususnya dalam kondisi 

ketidakberaturan maka disarankan : 

1. Perlu meningkatkan ketelitian dalam pemodelan ETABS sehingga tidak akan 

terjadi kesalahan dalam proses analisa. 

2. Perlu dilakukan analisa kembali dengan berbagi variasi bukaan lainnya 

terutama dari segi ukuran. 

3. Perlu dilakukan penelitian lebih lanjut untuk kondisi wilayah gempa yang 

beragam.
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Lampiran 1. Evaluasi Nilai Base Shear dan Perhitungan faktor skala 

terkoreksi 

a. Model Tanpa Bukaan 

𝑉1 =
𝑆𝐷1

𝑇 (
𝑅
𝑇)

 𝑊𝑡 =  
0.358

0.672951 (
8
1)

 181440,328 = 12065,45 𝑘𝑁 

𝑉 ≥ 0.85 𝑉1 

𝑉 ≥ 0.85 (12065,45) 

𝑉 ≥ 10255,63  

Arah X  : 610,42 ≥ 10255,63……………………….TIDAK OK! 

         Arah Y  : 533,4 ≥ 10255,63………..……………….TIDAK OK! 

Nilai base shear yang didapat dari kedua arah masih belum memenuhi 

standart Maka scale factor awal perlu dikalikan dengan nilai 0,85𝑉𝑖/𝑉 

sehingga menjadi: 

𝑈1 =  
0.85 𝑉1

𝑉
× 1,225 =  

0.85 (12065,45)

(610,42)
× 1,225 = 20,585 

𝑈2 =  
0.85 𝑉1

𝑉
× 1,225 =  

0.85 (12065,45)

(610,42)
× 0,3675 = 6,176 

𝑈1 =  
0.85 𝑉1

𝑉
× 1,225 =  

0.85 (12065,45)

(533,4)
× 0,3675 = 7,067  

𝑈2 =  
0.85 𝑉1

𝑉
× 1,225 =  

0.85 (12065,45)

(533,4)
× 1,225 = 23,558 

Kasus Arah 
Faktor  

Skala Awal 

Faktor 

Skala Terkoreksi 

RSPX 
U1 1,225 20,585 

U2 0,3675 6,176 

RSPY 
U1 0,3675 7,067 

U2 1,225 23,558 

 



104 
 

 
 

b. Model 1 

𝑉1 =
𝑆𝐷1

𝑇 (
𝑅
𝑇)

 𝑊𝑡 =  
0.358

0.718219 (
8
1)

 180798,521 = 11265𝑘𝑁 

𝑉 ≥ 0.85 𝑉1 

𝑉 ≥ 0.85 (11265) 

𝑉 ≥ 9573,807  

Arah X  : 577,61 ≥ 9573,807……..………………….TIDAK OK! 

         Arah Y  : 502,59 ≥ 9573,807………..……………….TIDAK OK! 

Dari hasil perbandingan nilai base shear kedua arah yang didapat pada model 

1 juga masih belum memenuhi syarat sehingga perlu adanya koreksi terhadap 

nilai scale factor awal untuk proses analisis menjadi : 

𝑈1 =  
0.85 𝑉1

𝑉
× 1,225 =  

0.85 (11265)

(577,61)
× 1,225 = 20,31 

𝑈2 =  
0.85 𝑉1

𝑉
× 1,225 =  

0.85 (11265)

(577,61)
× 0,3675 = 6,09 

𝑈1 =  
0.85 𝑉1

𝑉
× 1,225 =  

0.85 (11265)

( 502,59)
× 0,3675 = 7,002  

𝑈2 =  
0.85 𝑉1

𝑉
× 1,225 =  

0.85 (11265)

( 502,59)
× 1,225 = 23,34 

 

Kasus Arah 
Faktor 

Skala Awal 

Faktor 

Skala Terkoreksi 

RSPX 
U1 1,225 20,31 

U2 0,3675 6,09 

RSPY 
U1 0,3675 7,002 

U2 1,225 23,34 
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c. Model 2 

𝑉1 =
𝑆𝐷1

𝑇 (
𝑅
𝑇)

 𝑊𝑡 =  
0.358

0.75238 (
8
1)

 180798,521 = 11311,95 𝑘𝑁 

𝑉 ≥ 0.85 𝑉1 

𝑉 ≥ 0.85 (11311,95) 

𝑉 ≥ 9615,154  

Arah X  : 578.77 ≥ 9615,154……..………………….TIDAK OK! 

         Arah Y  : 503,48 ≥ 9615,154………..……………….TIDAK OK! 

Nilai base shear model 2 dikedua arahnya sama-sama belum memenuhi 

syarat. Maka perlu kembali melakukan koreksi terhadap nilai scale factor 

awal untuk kedua arahnya menjadi: 

𝑈1 =  
0.85 𝑉1

𝑉
× 1,225 =  

0.85 (11311,95 )

(578.77 )
× 1,225 = 20,351 

𝑈2 =  
0.85 𝑉1

𝑉
× 1,225 =  

0.85 (11311,95 )

(578.77)
× 0,3675 = 6,105 

𝑈1 =  
0.85 𝑉1

𝑉
× 1,225 =  

0.85 (11311,95 )

(503,48)
× 0,3675 = 7,018 

𝑈2 =  
0.85 𝑉1

𝑉
× 1,225 =  

0.85 (11311,95 )

( 503,48)
× 1,225 = 23,4 

 

Kasus Arah 
Faktor 

Skala Awal 

Faktor 

Skala Terkoreksi 

RSPX 
U1 1,225 20,35 

U2 0,3675 6,11 

RSPY 
U1 0,3675 7,02 

U2 1,225 23,4 
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d. Model 3 

𝑉1 =
𝑆𝐷1

𝑇 (
𝑅
𝑇)

 𝑊𝑡 =  
0.358

0.713704 (
8
1)

 180798,521 = 11336.26 𝑘𝑁 

𝑉 ≥ 0.85 𝑉1 

𝑉 ≥ 0.85 (11336.26 ) 

𝑉 ≥ 9635,821  

Arah X  : 578.77 ≥ 9635,821…….….……………….TIDAK OK! 

         Arah Y  : 503,48 ≥ 9635,821………..……………….TIDAK OK! 

Pada model 3 juga nilai base shear masih belum memenuhi persyaratan. Maka 

scale factor awal perlu dikoreksi menjadi: 

𝑈1 =  
0.85 𝑉1

𝑉
× 1,225 =  

0.85 (11336.26 )

(579)
× 1,225 = 20,25 

𝑈2 =  
0.85 𝑉1

𝑉
× 1,225 =  

0.85 (11336.26 )

(579)
× 0,3675 = 6,08 

𝑈1 =  
0.85 𝑉1

𝑉
× 1,225 =  

0.85 (11336.26 )

(503,48)
× 0,3675 = 7,025  

𝑈2 =  
0.85 𝑉1

𝑉
× 1,225 =  

0.85 (11336.26 )

(503,48)
× 1,225 = 23,42 

 

Kasus Arah 
Faktor 

Skala Awal 

Faktor 

Skala Terkoreksi 

RSPX 
U1 1,225 20,25 

U2 0,3675 6,08 

RSPY 
U1 0,3675 7,025 

U2 1,225 23,42 
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e. Model 4 

𝑉1 =
𝑆𝐷1

𝑇 (
𝑅
𝑇)

 𝑊𝑡 =  
0.358

0.718334 (
8
1)

 180087.231 = 11218,88 𝑘𝑁 

𝑉 ≥ 0.85 𝑉1 

𝑉 ≥ 0.85 (11218,88 ) 

𝑉 ≥ 9536,049  

Arah X  : 577.60 ≥ 9536,049……..…….………...….TIDAK OK! 

         Arah Y  : 502.94 ≥ 9536,049………..……………….TIDAK OK! 

Dari kedua arah baik arah X maupun arah Y pada model 3 nilai base shear 

masih kurang dari 85% base shear statis ekuivalen. Maka perlu adanya 

koreksi pada nilai scale factor awal menjadi: 

𝑈1 =  
0.85 𝑉1

𝑉
× 1,225 =  

0.85 (11218,88  )

(577.60)
× 1,225 = 20,22 

𝑈2 =  
0.85 𝑉1

𝑉
× 1,225 =  

0.85 (11218,88  )

(577.60)
× 0,3675 = 6,07 

𝑈1 =  
0.85 𝑉1

𝑉
× 1,225 =  

0.85 (11218,88  )

(502.94)
× 0,3675 = 6,97  

𝑈2 =  
0.85 𝑉1

𝑉
× 1,225 =  

0.85 (11218,88  )

(502.94)
× 1,225 = 23,23 

 

Kasus Arah 
Faktor 

Skala Awal 

Faktor 

Skala Terkoreksi 

RSPX 
U1 1,225 20,22 

U2 0,3675 6,07 

RSPY 
U1 0,3675 6,097 

U2 1,225 23,23 
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f. Model 5 

𝑉1 =
𝑆𝐷1

𝑇 (
𝑅
𝑇)

 𝑊𝑡 =  
0.358

0.718839 (
8
1)

 180087.231 = 11211𝑘𝑁 

𝑉 ≥ 0.85 𝑉1 

𝑉 ≥ 0.85 (11211 ) 

𝑉 ≥ 9529,349  

Arah X  : 577.66 ≥ 9529,349……..…….………...….TIDAK OK! 

         Arah Y  : 502.65 ≥ 9529,349………..……………….TIDAK OK! 

Sama seperti model-model sebelumnya nilaai base shear dari kedua arah X 

dan arah Y masih tidak memenuhi standar yang ditentukan. Maka perlu 

dilakukan perhitungan kembali nilai scale factor untuk memenuhi persyaratan 

menjadi: 

𝑈1 =  
0.85 𝑉1

𝑉
× 1,225 =  

0.85 (11211  )

(577.66)
× 1,225 = 20,21 

𝑈2 =  
0.85 𝑉1

𝑉
× 1,225 =  

0.85 (11211  )

(577.66)
× 0,3675 = 6,06 

𝑈1 =  
0.85 𝑉1

𝑉
× 1,225 =  

0.85 (11211  )

(502.65)
× 0,3675 = 6,97  

𝑈2 =  
0.85 𝑉1

𝑉
× 1,225 =  

0.85 (11211  )

(502.65)
× 1,225 = 23,22 

 

Kasus Arah 
Faktor 

Skala Awal 

Faktor 

Skala Terkoreksi 

RSPX 
U1 1,225 20,21 

U2 0,3675 6,06 

RSPY 
U1 0,3675 6,97 

U2 1,225 23,22 
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Lampiran 2. Kontrol Story Drift 

Untuk Arah X 

 

Lantai 
h 

Syarat 

Batas 

(0.02h) 
Tanpa 

Bukaan 

Model 

1 

Model 

2 

Model 

3 

Model 

4 

Model 

5 
Ket 

(mm) (mm) 

ATAP 2750 55 5,9294 6,1056 6,0646 6,0717 6,082 6,057 Aman 

LT25 2700 54 6,4265 6,6145 6,573 6,5771 6,5929 6,5622 Aman 

LT23 2700 54 6,8042 7,0257 6,9817 6,9843 7,0018 6,9731 Aman 

LT22 2700 54 7,162 7,4328 7,3855 7,3834 7,4065 7,3808 Aman 

LT21 2700 54 7,5827 7,9352 7,8841 7,8747 7,9052 7,8839 Aman 

LT20 2700 54 7,6682 8,1898 8,1331 8,1168 8,1571 8,1426 Aman 

LT19 2700 54 7,8856 8,5645 8,5022 8,4774 8,5274 8,5191 Aman 

LT18 2700 54 8,1746 8,9633 8,8956 8,8629 8,9219 8,921 Aman 

LT17 2700 54 8,4576 9,3238 9,2506 9,21 9,2779 9,2845 Aman 

LT16 2700 54 8,7401 9,6723 9,5938 9,5453 9,6217 9,6357 Aman 

LT15 2700 54 9,0009 10,0037 9,9198 9,8631 9,9479 9,9687 Aman 

LT12 2700 54 9,1765 10,2171 10,132 10,0691 10,1586 10,1856 Aman 

LT11 2700 54 9,2964 10,3817 10,2907 10,2192 10,0792 10,1668 Aman 

LT10 2700 54 9,4557 10,156 10,4725 10,3936 10,0465 10,0851 Aman 

LT9 2700 54 9,5525 10,2265 10,578 10,4921 10,1363 10,1749 Aman 

LT8 2700 54 9,4688 10,5056 10,5064 10,4145 10,418 10,4559 Aman 

LT7 2700 54 9,4358 10,0029 10,4376 10,3432 9,9267 9,9564 Aman 

LT6 2700 54 9,1257 10,1341 10,1099 10,0117 10,0679 10,0902 Aman 

LT5 2700 54 8,8965 9,7828 9,8307 9,7307 9,735 9,7413 Aman 

LT3 2700 54 8,5652 9,1207 9,4371 9,3001 9,0973 9,0793 Aman 

LT2 3200 64 9,334 10,05 10,2869 10,3219 10,0572 10,0107 Aman 

LT1 3220 64.4 8,901 8,717 9,2223 9,1499 8,713 8,6742 Aman 

GF 355 7.1 8,5953 8,4347 8,8465 8,5175 8,4343 8,4002 Aman 

LG 3200 64 3,5231 5,5521 3,7985 3,4452 5,5531 5,5291 Aman 

B1 3200 64 1,0436 2,9034 1,2367 1,0385 2,9046 2,8946 Aman 

BASE 0 0 0 0 0 0 0 0 Aman 
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Untuk Arah Y 

 

 

Lantai 
h 

Syarat 

Batas 

(0.02h) 
Tanpa 

Bukaan 

Model 

1 

Model 

2 

Model 

3 

Model 

4 

Model 

5 
Ket 

(mm) (mm) 

ATAP 2750 55 1,2383 1,9759 1,9624 1,8291 1,9763 1,9534 Aman 

LT25 2700 54 1,8337 2,7131 2,6839 2,5012 2,6987 2,6659 Aman 

LT23 2700 54 2,3142 3,3494 3,3099 3,0752 3,3273 3,2878 Aman 

LT22 2700 54 2,7377 3,9477 3,8994 3,6174 3,9204 3,8742 Aman 

LT21 2700 54 3,1121 4,5361 4,4791 4,1521 4,5062 4,4555 Aman 

LT20 2700 54 3,1683 4,9 4,8371 4,4801 4,8664 4,8127 Aman 

LT19 2700 54 3,2239 5,2773 5,2079 4,8197 5,2418 5,1861 Aman 

LT18 2700 54 3,3915 5,6477 5,5707 5,1517 5,6094 5,5515 Aman 

LT17 2700 54 3,5826 5,9871 5,9032 5,4561 5,9466 5,8878 Aman 

LT16 2700 54 3,7733 6,2986 6,2073 5,7352 6,2558 6,1962 Aman 

LT15 2700 54 3,9869 6,5856 6,4877 5,9952 6,5429 6,4843 Aman 

LT12 2700 54 4,0448 6,7021 6,5987 6,095 6,6565 6,5978 Aman 

LT11 2700 54 4,1976 6,9223 6,8153 6,2943 6,8778 6,8194 Aman 

LT10 2700 54 4,3128 7,0618 6,9522 6,4201 7,0168 6,9576 Aman 

LT9 2700 54 4,4148 7,1745 7,0652 6,5268 7,1301 7,0702 Aman 

LT8 2700 54 4,4367 7,2465 7,1437 6,6061 7,2068 7,1469 Aman 

LT7 2700 54 4,4392 7,0385 6,9477 6,4241 6,9997 6,9367 Aman 

LT6 2700 54 4,4759 7,0523 6,979 6,4589 7,02 6,9546 Aman 

LT5 2700 54 4,449 6,9295 6,8806 6,3752 6,8996 6,8316 Aman 

LT3 2700 54 4,4198 6,7274 6,724 6,2517 6,7071 6,6367 Aman 

LT2 3200 64 5,9753 8,4303 8,2859 7,6669 8,3826 8,3252 Aman 

LT1 3220 64.4 5,3212 6,6769 7,0146 6,5235 6,6525 6,5847 Aman 

GF 355 7.1 4,3879 4,7148 5,6079 5,1989 4,7056 4,662 Aman 

LG 3200 64 0,6091 2,0536 0,7423 0,6991 2,0519 2,0422 Aman 

B1 3200 64 0,3107 1,4306 0,3427 0,3031 1,4299 1,4246 Aman 

BASE 0 0 0 0 0 0 0 0 Aman 
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Lampiran 3. Perhitungan Kuat Geser 

a. Model Tanpa Bukaan 

Berdasarkan hasil analisa ETABS didapatkan 

Pu = 43930,68 kN = 43930680 N 

Mu = 226882,79 kN = 2,27 × 1011 Nmm 

Vu = 885,36 kN = 885360 N 

 Data teknis : 

 f’c = 37,35 Mpa 

 fy = 40 Mpa 

 lw = 5925 mm 

 h = 350 mm 

 d = 0,8 × lw = 0,8 × 5925 mm = 4740 mm 

 𝜆 = 1 (untuk beton normal) 

 

Berdasarkan SNI 03-2847-2013 kuat geser nominal 𝑉𝑐 dinding geser diambil 

dari nilai yang lebih kecil dari nilai yang dihitung dari persamaan : 

 

𝑉𝑐 = 0,27𝜆√𝑓𝑐′ℎ𝑑 +  
𝑁𝑢𝑑

4𝑙𝑤
           

               =  0,27(1)√37,35(350)(4740) +  
43930680(4740)

4(5925)
 

    = 11523644.35 𝑁 

         Atau 

 

𝑉𝑐 = [0,05𝜆√𝑓𝑐′ +  
𝑙𝑤 (0,1𝜆√𝑓𝑐′ + 0,2

𝑁𝑢
𝑙𝑤ℎ

)

𝑀𝑢
𝑉𝑢

−  
𝑙𝑤
2

] ℎ𝑑 

𝑉𝑐 = [0,05(1)√37,35 +  
5925 (0,1(1)√27,35 + 0,2

43930680
5925(350)

)

2,27 × 1011

885360
− 

5925
2

] (350 × 4740) 

     = 695079 𝑁 

 

Maka nilai Vc untuk Model Tanpa Bukaan adalah 695079 N 
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b. Model 1 

Berdasarkan hasil analisa ETABS didapatkan 

 

Pu = 43422,89 kN = 43422890 N 

Mu = 211832,67 kN = 2,12 × 1011 Nmm 

Vu = 220,47 kN = 220470 N 

Data teknis : 

f’c = 37,35 Mpa 

fy = 40 Mpa 

lw = 5925 mm 

h = 350 mm 

d = 0,8 × lw = 0,8 × 5925 mm = 4740 mm 

𝜆 = 1 (untuk beton normal) 

Berdasarkan SNI 03-2847-2013 kuat geser nominal 𝑉𝑐 dinding geser 

diambil dari nilai yang lebih kecil dari nilai yang dihitung dari persamaan : 

 

𝑉𝑐 = 0,27𝜆√𝑓𝑐′ℎ𝑑 +  
𝑁𝑢𝑑

4𝑙𝑤
             

                =  0,27(1)√37,35(350)(4740) + 
43422890(4740)

4(5925)
 

     = 11422086.35 𝑁  

Atau 

𝑉𝑐 = [0,05𝜆√𝑓𝑐′ +  
𝑙𝑤 (0,1𝜆√𝑓𝑐′ + 0,2

𝑁𝑢

𝑙𝑤ℎ
)

𝑀𝑢

𝑉𝑢
− 

𝑙𝑤

2

] ℎ𝑑 

𝑉𝑐 = [0,05(1)√37,35 + 
5925 (0,1(1)√27,35 + 0,2

43422890
5925(350)

)

2,12 ×  1011

220470
− 

5925
2

] (350 × 4740) 

     = 556194 𝑁 

 

Maka nilai Vc untuk Model 1 adalah 𝟓𝟓𝟔𝟏𝟗𝟒 𝑵  
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c. Model 2 

Berdasarkan hasil analisa ETABS didapatkan 

 

Pu = 43649,61 kN = 43649610 N 

Mu = 215752,14 kN = 2,16 × 1011 Nmm 

Vu = 407,33 kN = 407330 N 

Data teknis : 

f’c = 37,35 Mpa 

fy = 40 Mpa 

lw = 5925 mm 

h  = 350 mm 

d  = 0,8 × lw = 0,8 × 5925 mm = 4740 mm 

𝜆  = 1 (untuk beton normal) 

Berdasarkan SNI 03-2847-2013 kuat geser nominal 𝑉𝑐 dinding geser 

diambil dari nilai yang lebih kecil dari nilai yang dihitung dari persamaan : 

 

𝑉𝑐 = 0,27𝜆√𝑓𝑐′ℎ𝑑 +  
𝑁𝑢𝑑

4𝑙𝑤
             

     =  0,27(1)√37,35(350)(4740) +  
43649610(4740)

4(5925)
 

     = 11467430,35 𝑁 

Atau 

𝑉𝑐 = [0,05𝜆√𝑓𝑐′ +  
𝑙𝑤 (0,1𝜆√𝑓𝑐′ + 0,2

𝑁𝑢

𝑙𝑤ℎ
)

𝑀𝑢

𝑉𝑢
− 

𝑙𝑤

2

] ℎ𝑑 

𝑉𝑐 = [0,05(1)√37,35 + 
5925 (0,1(1)√27,35 + 0,2

43649610
5925(350)

)

2,16 ×  1011

407330
− 

5925
2

] (350 × 4740) 

     = 596914 𝑁 

 

Maka nilai Vc untuk Model 2 adalah 𝟓𝟗𝟔𝟗𝟏𝟒 𝑵  
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d. Model 3 

Berdasarkan hasil analisa ETABS didapatkan 

 

Pu = 43676.42 kN = 43676420 N 

Mu = 211999.467 kN = 2,12 × 1011 Nmm 

Vu = 647.08 kN = 647080 N 

Data teknis : 

f’c = 37,35 Mpa 

fy = 40 Mpa 

lw = 5925 mm 

h  = 350 mm 

d  = 0,8 × lw = 0,8 × 5925 mm = 4740 mm 

𝜆  = 1 (untuk beton normal) 

Berdasarkan SNI 03-2847-2013 kuat geser nominal 𝑉𝑐 dinding geser 

diambil dari nilai yang lebih kecil dari nilai yang dihitung dari persamaan : 

 

𝑉𝑐 = 0,27𝜆√𝑓𝑐′ℎ𝑑 +  
𝑁𝑢𝑑

4𝑙𝑤
             

     =  0,27(1)√37,35(350)(4740) +  
43676420(4740)

4(5925)
 

                  = 11472792,4 𝑁 

 

Atau 

𝑉𝑐 = [0,05𝜆√𝑓𝑐′ +  
𝑙𝑤 (0,1𝜆√𝑓𝑐′ + 0,2

𝑁𝑢

𝑙𝑤ℎ
)

𝑀𝑢

𝑉𝑢
− 

𝑙𝑤

2

] ℎ𝑑 

𝑉𝑐 = [0,05(1)√37,35 + 
5925 (0,1(1)√27,35 + 0,2

43676420
5925(350)

)

2,12 ×  1011

647080
− 

5925
2

] (350 × 4740) 

 

     = 652983 𝑁 

 

Maka nilai Vc untuk Model 3 adalah 𝟔𝟓𝟐𝟗𝟖𝟑 𝑵  
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e. Model 4 

Berdasarkan hasil analisa ETABS didapatkan 

 

Pu = 42408.37 kN = 42408370 N 

Mu = 209943.739 kN = 2,1 × 1011 Nmm 

Vu = 214.52 kN = 214520 N 

Data teknis : 

f’c = 37,35 Mpa 

fy = 40 Mpa 

lw = 5925 mm 

h  = 350 mm 

d  = 0,8 × lw = 0,8 × 5925 mm = 4740 mm 

𝜆  = 1 (untuk beton normal) 

Berdasarkan SNI 03-2847-2013 kuat geser nominal 𝑉𝑐 dinding geser 

diambil dari nilai yang lebih kecil dari nilai yang dihitung dari persamaan : 

 

𝑉𝑐 = 0,27𝜆√𝑓𝑐′ℎ𝑑 +  
𝑁𝑢𝑑

4𝑙𝑤
             

     =  0,27(1)√37,35(350)(4740) +  
42408370(4740)

4(5925)
 

                  = 11219182,4 𝑁 

Atau 

𝑉𝑐 = [0,05𝜆√𝑓𝑐′ +  
𝑙𝑤 (0,1𝜆√𝑓𝑐′ + 0,2

𝑁𝑢

𝑙𝑤ℎ
)

𝑀𝑢

𝑉𝑢
− 

𝑙𝑤

2

] ℎ𝑑 

𝑉𝑐 = [0,05(1)√37,35 + 
5925 (0,1(1)√27,35 + 0,2

42408370
5925(350)

)

2,1 ×  1011

214520
−  

5925
2

] (350 × 4740) 

 

     = 554307 𝑁 

 

Maka nilai Vc untuk Model 3 adalah 𝟓𝟓𝟒𝟑𝟎𝟕 𝑵  
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f. Model 5 

Berdasarkan hasil analisa ETABS didapatkan 

 

Pu = 42404.9 kN = 42404900 N 

Mu = 208816.375 kN = 2,08 × 1011 Nmm 

Vu = 208.15 kN = 208150 N 

Data teknis : 

f’c = 37,35 Mpa 

fy = 40 Mpa 

lw = 5925 mm 

h = 350 mm 

d = 0,8 × lw = 0,8 × 5925 mm = 4740 mm 

𝜆 = 1 (untuk beton normal) 

Berdasarkan SNI 03-2847-2013 kuat geser nominal 𝑉𝑐 dinding geser 

diambil dari nilai yang lebih kecil dari nilai yang dihitung dari persamaan : 

 

𝑉𝑐 = 0,27𝜆√𝑓𝑐′ℎ𝑑 +  
𝑁𝑢𝑑

4𝑙𝑤
 

     =  0,27(1)√37,35(350)(4740) +  
42404900(4740)

4(5925)
             

                   = 11218488.35 𝑁 

 

Atau 

𝑉𝑐 = [0,05𝜆√𝑓𝑐′ +  
𝑙𝑤 (0,1𝜆√𝑓𝑐′ + 0,2

𝑁𝑢

𝑙𝑤ℎ
)

𝑀𝑢

𝑉𝑢
− 

𝑙𝑤

2

] ℎ𝑑 

𝑉𝑐 = [0,05(1)√37,35 + 
5925 (0,1(1)√27,35 + 0,2

42404900
5925(350)

)

2,08 ×  1011

208150
− 

5925
2

] (350 × 4740) 

 

     = 553142 𝑁 

 

Maka nilai Vc untuk Model 5 adalah 𝟓𝟓𝟑𝟏𝟒𝟐 𝑵  
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Berdasarkan perhitungan kuat geser dari masing-masing model maka 

didapatkan hasil sebagai berikut: 

Model 
Kuat Geser 

(N) 

Tanpa Bukaan 695079 

1 𝟓𝟓𝟔𝟏𝟗𝟒 

2 𝟓𝟗𝟔𝟗𝟏𝟒 

3 𝟔𝟓𝟐𝟗𝟖𝟑 

4 𝟓𝟓𝟒𝟑𝟎𝟕 

5 𝟓𝟓𝟑𝟏𝟒𝟐 
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Modul Penggunaan Software ETABS 

1. Sebagai langkah awal sebaiknya tentukan satuan yang akan dipergunakan 

sesuai keinginan dengan mengubahnya di kotak pilihan pada pojok kanan 

bawah pada tampilan awal ETABS. Hal ini dilakukan hanya untuk 

kemudahan saja, walaupun nanti tetap dapat dirubah sewaktu-waktu. 

 

 

 

 

 

 

 

Tampilan awal ETABS 

2. Setelah itu untuk memulai proses pemodelan pilih Menu file-new model. 

Kemudian akan muncul pop up (New Model Initialization). Pilih No untuk 

membuat model baru tanpa mengambil dari file ETABS yang sudah ada pada 

komputer. Sedangkan untuk pilihan lainnya : 

 Choose.edb dipilih jika ingin membuat model baru dengan definisi dan 

preferinsinya mengambil dari file ETABS yang sudah ada pada 

komputer. 

 Default.edb dipilih jika ingin membuat model baru dengan definisi dan 

preferinsinya dimulai dengan default tang sudah built-in didalam 

ETABS. 

 

 

 

 

 

New Model Initialization 

3. Akan muncul kotak dialog “Building Plan Grid System and Story Definition” 

lalu pilih Grid only pada structural object.  
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Kotak Dialog Building Plan Grid System and Story Definition 

Kemudian aktifkan Custom Grid Spacing dan klik Edit Grid  Maka 

akan muncul kotak dialog Define Grid Data. masukan jarak-jarak sumbu 

acuan yang searah sumbu X maupun sumbu Y. pada kotak Display Grid as, 

ada dua pilihan yaitu Ordinates untuk menetuan jarak menggunakan metode 

sumbu koordinat, dan juga Spacing untuk menentukan jarak dengan 

menggunakan metode jarak antar sumbu. Dalam proses memasukan data 

jarak harus diperhatikan satuan yang digunakan agar data yang dimasukan 

sesuai. Setelah semua data telah dimasukan lalu Klik OK untuk 

mengakhirinya, 

 

 

 

 

 

 

 

 

  

 

Kotak Dialog Define Grid Data. 

Kemudian aktifkan Custom Story Data dan klik Edit Story Data  Maka 

akan muncul kotak dialog Story Data. Masukan semua data ketinggian setiap 

lantai. 
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Story Data 

Setelah semua data grid dimension dan story dimension dimasukan 

maka klik OK dan akan muncul tampilan gambar sumbu-sumbu yang telah 

dimasukan tadi. 

  

 

 

 

 

 

 

 

 

Grid 

4. langkah selanjutnya adalah menentukan material properties sesuai data 

perencan dengan cara klik Define > Material Propertise. Maka akan muncul 

kotak dialog Define Materials. Untuk menambahkan material baru sesuai 

perencanaan maka klik Add New Material, kemudian masukan data material 

yang akan digunakan. 
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Menu Define Material Properties 

 

 

 

 

 

 

 

 

Kotak Dialog Define Material 

 

Setelah itu ditampilkan kotak dialog Material Property Data karena semua 

material yang akan dibuat menggunakan material beton pada type of design 

pilih concrete. Kemudian masukan data material beton sesuai desain seperti 

fc, fy(mutu baja tulangan geser), dan fys (mutu baja tulangan geser) . Untuk 

mass per unit volume dan weight  per unit volume biasanya defaultnya sudah 

sesuai yaitu 24kN/m3. Sedangkan untuk Modulus elastisitas dapat dihitung 

berdasarkan rumus 4700√fc’.  Setelah data sudah sesuai, kemudian tekan OK 

untuk keluar. 

 

 

 

 

 

 

Material Property Data 
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5. Kemudian define dimensi struktur, untuk komponen balok dan kolom dapat 

dilakukan dengan cara Define > Frame Section . Define Frame Properties 

 

 

 

 

 

 

Menu Define Frame Section 

 

Setelah itu akan muncul Kotak Dialog Define Frame Properties. Kemudian 

karena semua komponen stuktur yang digunakan semua berbentuk persegi 

empat maka pilih Add Rectangular untuk membuat komponen struktur baru.  

 

 

 

 

 

 

 

 

 

 

Kotak Dialog Define Frame Properties 

 

Setelah proses diatas maka akan mucul kotak dialog seperti yang ditunjukan 

pada gambar dibawah ini. Beri nama komponen struktur yang akan 

didefinisikan, dan masukan ukuran tinggi (Depth) dan lebar (Width) frame. 

Ubah juga jenis material yang dipakai untuk setiap komponen struktur yang 

di define sesuai perencanaan. 

 

 

 

 

 

 

 

 

 Kotak Dialog Rectangular Section 
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Untuk menentukan jenis frame sebagai balok atau kolom, klik pada 

reinforcement, kemudian pilih design type sebagai balok atau kolom. Apabila 

frame yang akan dimasukan datanya adalah balok, maka akan muncul form 

seperti pada gambar dibawah ini. Kemudian input data selimut beton balok 

pada Concrete Cover to Rebar Center.  

 

 

 

 

 

 

 

 

Reinforcement Data Beam 

Namun apabila frame yang akan dimasukan datanya adalah kolom, maka 

akan muncul kotak dialog seperti yang ditunjukan pada gambar dibawah ini: 

 

 

 

 

 

 

 

Reinforcement Data Column 

Khusus pada input data kolom, pilih jenis tulangan yang akan dipakai (spiral 

atau tulangan tegak). Kemudian isi selimut beton pada Rectangular 

Reinforcemenet-Cover to Rebar Center. Selain itu masukan jumlah dan 

ukuran tulangan yang digunakan. 
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Namun sebelum mengakhiri proses define frame section dari komponen 

balok dan kolom,  terlebih dahulu properties komponen struktur tersebut 

harus diubah kekakuannya sesuai syarat SNI. Dengan cara klik Set Modifier 

pada kotak dialog Rectangular Section kemudian ubah nilai Property 

Modifier sesuai dengan fungsinya, seperti sebagai berikut: 

 Kolom : moment of inertia about 2 dan 3 axis = 0,7 

 Balok : moment of inertia about 2 dan 3 axis = 0,35 

       Kemudian klik OK dan lakukan cara yang sama untuk define frame lainnya 

 

 

 

 

 

Analysis Property Modification untuk kolom dan balok 

6. Kemudian define komponen pelat dan dinding dengan cara Define > 

Wall/Slab/Deck Section.  

 

 

 

Menu Define Wall/Slab/Deck Section 

Untuk mendefinisikan ukuran pelat baru sesuai dengan perencanaan pilih Add 

New Slab. maka akan muncul kotak dialog wall/slab section.  

 

 

 

 

Kotak Dialog Define Wall/Slab/Deck Properties 
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Kotak Dialog Wall/Slab Section 

Beri nama pelat yang akan dipakai, ganti material yang dipakai untuk pelat 

sesuai dengan perencanaan dan material yang telah didefine sebelumnya dan 

ganti ukuran tebal pelat. Untuk type profil berupa Membrane. Sama seperti 

balok dan kolom, pada komponen pelat juga perlu diubah kekakuannya sesuai 

SNI dengan cara klik set modifers lalu ubah pada membrane f11-f22-f12 dan 

bending  m11-m22-m12 menjadi 0,25. 

 

 

 

 

 

 

 

 

 

set modifers slab 

Sedangkan untuk komponen dinding/ wall pilih Add New Wall pada kotak 

dialog Define Wall/Slab/Deck Section untuk membuat dimensi dinding baru. 

Kemudian beri nama wall yang akan dipakai, ganti material yang dipakai 

untuk wall sesuai dengan perencanaan dan material yang telah didefine 

sebelumnya dan ganti ukuran tebal pelat. Untuk type profil berupa Shell.  
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Kotak Dialog Wall/Slab Section 

Sama seperti pelat komponen wall juga perlu diubah kekakuannya sesuai 

SNI. namun berbeda dengan pelat dengan cara klik set modifers nilai yang 

diubah yaitu pada membrane f11-f22 dan bending  m11-m22 menjadi 0,7. 

 

  

 

 

 

 

 

set modifers wall 

7. Define respon spektrum sebagai beban gempa dengan cara pilih Define > 

Response Spectrum Function.  

 

 

 

 

 

Response Spectrum Function 
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Kemudian akan muncul kotak dialog Define Response Spectrum Function, 

klik Add User Spektrum karena tipe gempa di Indonesia tidak tersedia di 

ETABS. Kemudian input data Period dan Acceleration (percepatan gempa) 

sesuai dengan perhitungan pada kotak dialog Respons Spectrum Function 

Definition lalu klik ok. 

 

 

 

 

 

 

kotak dialog Define Response Spectrum Function  

 

 

 

 

 

 

 

 

 

 

Response Spectrum Function Definition 

8. Menentukan spektrum gempa. Pilih Define > Respon Spectrum Case 

kemudian akan muncul kotak dialog Define Response Spectra. 
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Define Respon Spectrum Case 

setelah muncul Define Response Spectra klik Add New Spectrum. Masukan 

data panda kotak dialog Response Spectrum, data yang dimasukan seperti 

Spectrum Case Name berupa RSPX dan RSPY. Input Response Spectrume 

untu arah X isikan Function dan Scale Factor pada kotak U1 dan untuk arah 

Y pada kotak U2 sesuai dengan perhitungan. 

 

 

 

 

Kotak Dialog Define Response Spectra 

 

 

 

 

 

 

 

 

Response Spectrume Case Data 
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9. Menentukan beban yang akan bekerja pada bangunan dengan cara Klik 

Define > Static Load Case kemudian input jenis-jenis beban yang akan 

digunakan untuk proses analisis. 

 

 

 

 

 

 

 

Define Static Load Case 

 

 

 

 

 

Kotak Dialog Define Static Load Case Names 

10. Menentukan kombinasi pembebanan dengan cara klik Define > Load 

Combination setelah itu muncul kotak dialog Define Load Combination pilih 

Add New Combo kemudian masukan scale factor setiap jenis beban pada 

masing-masing kombinasi yang telah direncanakan sebelumnya. 

 

 

 

 

 

Define Load Combination 
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Load Combination Data 

11. Menggambar kolom, untuk memulai menggambar kolom dilakukan dengan 

cara pilih menu Draw > Draw Line Object > Create Columns in Regions or 

at Click. Kemudian akan muncul Propertis of Object untuk memberi pilihan 

dimensi kolom yang akan digunakan pada baris property. Bila pada suatu 

struktur kolom direncanakan tidak tegak lurus sumbu X atau sumbu Y atau 

membentuk sudut tertentu, isi pada baris angel dengan besar sudut arah kolom 

yang akan digambar. 

 

 

 

 

 

Draw Column 

 

 

 

 

Properties of Object 
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Untuk penggambarannya sendiri klik satu kali pada titik-titik letak kolom 

sesuai gambar denah rencana. 

 

12. Menggambar balok dengan klik menu Draw > Draw Line Object > Draw 

line. kemudian tentukan type balok yang akan digunakan. Setelah itu 

gambarkan balok pada garis grid yang telah dibuat sebelumnya dengan cara 

klik satu kali pada titik ujung awal lokasi balok, dan klik lagi pada ujung akhir 

lokasi balok. 

 

 

 

 

 

 

Draw Line Object 

13. Menggambar pelat dengan klik menu Draw > Draw Area Object kemudian 

tentukan type pelat yang akan digunakan. Setelah itu gambarkan plat sesuai 

gambar perencanaan. 

 

 

 

 

 

 

 

Draw Area Object 

ada beberapa cara dalam menggambar pelat: 

 Draw Area (biasanya digunakan untuk menggambar bentuk pelat 

yang tidak beraturan bentuknya. Cara penggunaannya klik satu kali 

pada semua ujung lokasi plat). 

 Draw Rectangular Areas (biasanya digunakan untuk pelat yang 

berbentuk persegi empat. Cara pemakaiannya yaitu klik pada titik 

ujung lokasi pelat, kemudian pindahkan mouse dengan tetap ditekan 

pada titik ujung pelat yang lain dan lepaskan mouse). 



132 
 

 
 

 Create Areas at Click (cara penggambarannya tinggal klik pada area 

lokasi pelat yang akan digambar biasanya disesuaikan dengan grid 

yang telah dibuat) 

 

14. Menggambar wall dengan klik menu Draw > Draw Area Object > Draw 

Walls (Plan) pada Properties of Object tentukan type wall yang akan 

digunakan. Setelah itu gambarkan wall pada grid yang sudah dibuat sebagai 

acuan pemodelan. 

 

 

 

 

 

Draw Walls 

15. Input beban mati dan beban hidup untuk itu pilih plat yang akan diinput beban 

kemudian pilih menu Assign > Shell/ Area loads > Uniform. Kemudian akan 

muncul kotak dialog Uniform Surface Load Pilih Load Case Name antara 

Dead/Live disesuaikan dengan jenis beban yang akan dimasukan. Masukan 

nilai beban pada kotak Load dan perhatikan satuan yang digunakan lalu klik 

OK untuk mengakhirinya. 

 

 

 

 

 

 

Assign Shell/ Area loads 

 

 

 

 

 

 

 

 

Kotak Dialog Uniform Surface Load 
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16. Menentukan jenis perletakan pada bagian bawah struktur. Select semua titik-

titik yang berada pada lantai base kemudian pilih menu Assign > Joint/ Point 

> Restraints/Support. Maka akan muncul kotak dialog Assign Restraints pilih 

jenis support yang akan digunakan lalu klik Ok untuk keluar. 

 

 

 

 

 

Assign Restraints Support  

 

 

 

 

 

 

Kotak Dialog Assign Restraints 

 

17. Setelah semua pemodelan setiap elemen struktur selesai langkah selanjutnya 

adalah proses analisis. Namun sebelum melakukannya klik menu Analyze > 

Set Analysis Option.  

 

 

 

 

Set Analysis Option. 
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Setelah itu akan muncul kotak dialog Analysis Option pilih Full 3D pada 

Building Active of Freedom dan checklist pada Dynamic Analysis lalu klik 

Ok. Setelah itu klik Analysis lalu Run Analysis. 

 

 

 

 

 

 

 

kotak dialog Analysis Option 
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